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1 INTRODUCTION 

1.1 PURPOSE OF THE DOCUMENT 

The document at hand reports results and findings of the evaluation process 

performed during the development of the HarmoSearch mapping tool. The overall 

goal of the evaluation process is to improve the quality of the mapping tool with 

regards to software components.  

At the beginning of the project a basic evaluation procedure was defined with a set 

of dedicated activities that have been performed every time a new prototypical 

release candidate was released. Overall 4 release candidates have been developed. 

The evaluation procedure covered internal and external evaluations. The internal 

evaluation was done by the developers, and was focused on testing the developed 

software artifacts (technical tests), whereas the external evaluation addressed the 

usability of the main components that provide a graphical user interface (functional 

tests). 

All in all the evaluation results showed that the developed components are of good 

quality. The expert users judged the usability and functionality of the HarmoSearch 

mapping tool mostly fulfilled. However, the early releases showed usability deficits 

regarding the mapping editor.  

1.2 DEFINITION OF TERMS AND ABBREVIATIONS 

The following terms and definitions are used throughout this document:  

 Release candidate: The development of the HarmoSearch mapping tool 

followed an iterative approach. Accordingly, several versions of the 

HarmoSearch mapping tool had been developed. A release candidate denotes 

to the most recent version of the prototypical implementation of the 

HarmoSearch mapping tool ready to be evaluated. 

 Mapping tool: The HarmoSearch mapping tool is a stand-alone tool 

dedicated to support domain-experts (expert users of a specific domain) in 

creating proper mappings between elements of a source schema and 

elements of a target schema. 

 Internal evaluation [Technical evaluation]: Defined in details in this 

document, this evaluation consists of technical unit tests performed by 

developers in order to ensure the robustness of the developed software 

artifacts. 

 External evaluation [Functional evaluation]: Defined in details in this 

documents, this evaluation consists of using the components of the 

HarmoSearch system in order to ensure that they meet requirements and can 

be used by non-technical users. 

 

1.3 RELATIONSHIP WITH OTHER DOCUMENTS 

Initial inputs for this document are deliverable D2.1 Use Case Specification, D2.2 

Architectural Design and D6.1 First Running Prototype with Main Functionality 

Integrated. D2.1 defines the main functionalities and requirements whereas D2.2 is 
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used to describe the basic architecture of the HarmoSearch as well as the Harmonise 

system. D6.1 provides detailed information about the main building blocks and 

functions of the HarmoSearch mapping tool. 

Finally, this document is partly related to D7.1 Compiled Collection of Acceptance 

Notes, which addresses the evalution of the HarmoSearch portal. Although the 

targets of evaluation are different, there are some connections between the portal 

and the mapping tool that are reflected in the external (functional) evaluation 

results. 

1.4 STRUCTURE OF THE DOCUMENT 

The document is structured as follows:  

 Section 2 describes the context: first an introduction to the Mapping Tool is 

given, then the evaluation process is summarized (the complete description is 

provided in D7.1 – Compiled Collection of Acceptance Notes)  

 Section 3 summarizes the content of each release candidate. 

 Section 4 lists future recommendations as identified during the external 

evaluations.  

 Appendix A provides the list of requirements for each release candidate. 

 Appendix B contains the compiled evaluation documents. 

 Appendix C contains the acceptance reports. 
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2 CONTEXT 

2.1 OVERVIEW OF THE MAPPING TOOL FUNCTIONALITIES 

The Mapping Tool is a stand-alone application that can be deployed in any 

harmonisation project. Mapping artefacts are created using a propose-critique-

modify approach, i.e., a mixture of automatic matching and user interaction. The 

tool makes a matching proposal and presents this proposal to the user. The user 

then supervises the proposal and accepts or rejects it partially or completely, 

optionally asking for a new proposal. Alternatively, the user may manually 

manipulate proposals in cases the employed matching algorithms do not come up 

with a correct solution. Finally, from the defined matches the tool creates a mapping 

artefact that can then be uploaded to the HarmoSearch portal. 

The main functionalities of the Mapping Tool are: 

 Creation of a new mapping project: to create the central repository which 

contains all resources that are necessary in order to create a proper mapping. 

 Setting up of the mapping project: to add the necessary resources that 

support the development of a proper mapping definition: schema files 

representing structural information about the source and the target data; 

mapping patterns to define the actual mappings; transformation configuration 

file dealing with the basic settings that drive the transformation procedure; 

mapping filter to guide the user towards a proper mapping definition. 

 Setting up of the mapping file: to specify the source and the target 

schema. 

 Creation of the proper mapping definition: to create the actual mapping. 

The mapping is done using the HarmoSearch mapping editor graphically 

supporting the user in creating proper mapping links. A mapping link 

represents a connection between a source and a target element. 

 Running and testing the transformation: to create output files according 

to the process specification (e.g. XML or HTML) in order to visualize the final 

outcome and thus to provide immediate feedback to the user.  

 Export mechanism: to save a mapping representation to a specific file, in 

order to make the transformed mapping available for other applications or 

further purposes. 

 Automatic upload of the output mapping files to the HarmoSearch 

portal: to directly upload the mapping files to the HarmoSearch portal from 

the Mapping Tool itself, instead of doing it manually through the Mapping 

Store user interface of the portal. 

 Mapping of reference lists: to map and combine with an existing data 

mapping dedicated reference values, i.e. those domain specific values - such 

as an event category or an hotel classification - that refer to elements that 

are not part of the data schema but refer to data pieces that only exist in the 

database of an individual customer. These values usually belong to some kind 

of list that serves as the reference for several applications and organisations. 
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 Definition of mapping variables: to store and reuse during the creation of 

a data mapping some mapping parameters, in order to reduce the manual 

effort for the user when applying a mapping pattern, thus saving time and at 

the same time decreasing the risk of failure. 

 Import of an existing mapping project: to import and reuse existing 

mapping projects as Zip file or from a folder on the local hard-disk. 

 Export of an existing mapping project: to expoprt mapping projects that 

exist in the current workspace as an archive file. 

 Installation of third party plug-ins: to extend the HarmoSearch mapping 

tool by downloading and installing new software components. 

 Update the HarmoSearch mapping tool: to update installed software 

components in the system. 

2.2 OVERVIEW OF THE EVALUATION METHODOLOGY 

The purpose of the evaluation report is to define the evaluation procedure for the 

HarmoSearch mapping tool. Since HarmoSearch is an information and 

communication technology (ICT) research project the main deliverables are software 

artifacts.  

Specific evaluation activities were used to determine if the HarmoSearch mapping 

tool met the expectations in regard of project execution, usability, and user 

satisfaction. The activities that were performed during the entire project had been 

used to determine if the evaluation was effective and how the actual users felt about 

the final release.  

The following activities had been performed during the project:  

 During the development phase unit tests have been used evaluating 

dedicated parts of the developed source code 

 Evaluation testing by expert users to evaluate the software quality perceived 

by the expert and end user 

The HarmoSearch mapping tool has been evaluated from two distinct perspectives:  

 Internal evaluation 

o The internal evaluation is a technical evaluation, which consists in unit 

tests and bug fixing, and is conducted by the developers, (RTD 

partners).  

 External evaluation  

o The external evaluation is a functional evaluation, and aims at 

measuring the success and usability of the tool. It is conducted by 

three kind of users: expert users that are internal project partners 

(SME partners), real users that are internal project partners (class 

OTHER partners in HarmoSearch) and domain-experts that are not 

participating in the HarmoSearch project. 

All partners of the project have been involved as participants in the external 

(functional) evaluation of the various Mapping Tool release candidates, following the 

evaluation methodology described in details in the Deliverable D7.1 “Compiled 

collection of acceptance note”. 
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It was decided not to involve users external to the project to actually perfom 

evaluation of the first phases of the mapping tool development, in order to avoid the 

risk of generating discouragement, after all the aim of this project was to develop a 

prototype. SPK and Museumsmedien were chosen to act out the roles of participant 

was well as domain-expert as they both represent the cultural heritage users. The 

portal managed by the SPK, euromuse.net, managged to aggregate the Finnish 

Museum Association as data provider with use of the prototype, as this was 

gradually done with each release; SPK took over the actual mapping process with 

support of TU Wien for the Finnish Museum Association. Understandibly it was never 

expected for them to yet test the application, for the aforemention reason. The 

successful result of this connection was presented to the Museum Association and 

thus now the routine of data exchange between both partners is asured. This real 

use case was therefore used as show case and for elaborating the manual of the tool 

(to read more see D6.4 Manual for the HarmoSearch Mapping Tool). 

In addition to the external evaluation realised by SPK, the usability of the mapping 

tool was also assessed by an external domain expert, using the before-last mapping 

tool candidate (during Release 4). This evaluation is to be found in section 3.6 

Evaluation with external domain experts. 
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3 EVALUATION SESSIONS 

The evaluation has been conducted on 4 release candidates of the HarmoSearch 

mapping tool. All partners were involved and participated in the review meetings, 

which have been organized in order to share experiences and evaluate if the 

presented release candidates fulfilled the requirements as expected. The business 

users as well as the evaluation leader have performed the evaluations. These have 

been conducted in two phases. In the first phase, the business users were the expert 

users belonging to the SME partners, as well as the real users belonging to the 

OTHER partners of the project, and in the later phase, the business users were 

external domain-experts. TU-Wien as evaluation leader was also responsible for 

collecting and distributing the results of the evaluations within the HarmoSearch 

consortium.  

All in all 4 external evaluations have been conducted; each, with the corresponding 

release candidate version of the HarmoSearch mapping tool. The evaluations took 

place throughout the whole project: M10, M14, M21 and M27. 

3.1 THE FOUR RELEASE CANDIDATES 

The scope of the first release was to make a domain expert with no previous 

knowledge of mapping acquainted with the process but also basically present a first 

proposal in order to gather first impressions of such users, and although the aimed 

basic functionalities worked as expected, the usability expectations were not met, 

therefore the following candidate concentrated in offering this integrated help and 

guidance to the user. The third candidate presented many new components that 

drastically reduced the time consumed in performing a simple mapping but also 

evidenced the complexity of the process, so the last fourth candidate focused in fine 

tuning the developed functionalities towards making them usable and 

comprehensible to the user.   

3.2 EVALUATION OF RC1 

The first evaluation was performed in month 10 (M10). Lead by TU-Wien (evaluation 

leader) SPK (participant) performed the evaluation of release candidate 1 (RC1). 

RC1 was the first prototypical implementation of the HarmoSearch mapping tool. The 

main purpose of the RC1 evaluation was to determine if the basic functionality for 

deliverable D6.1 was fulfilled. The collected results were presented in the next 

consortium meeting (review meeting). All partners accepted RC1. The identified 

issues had been discussed and added to the requirements list of the next release 

candidate. 

RC1 presented basic functionalities in order to perform tasks such as opening and 

closing the application, import and delete files from the workspace a short 

introduction on the interface (not exhaustive for this was to be improved in later 

releases) and a more detailed introduction of the data mapping process: to choose 

the matching data elements and the modelling of this match with use of dialogue 

windows. Generally, an integrated guidance was missed. The modelling dialogue was 

too technnical which reduced both understanding and trustworthiness of the tool 

because the steps were, for non-technical users, completely foreign. 
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The results of the evaluation are attached in Appendix B.1 - Test cases for release 

candidate 1. 

The Acceptance notes for RC1 are attached in Appendix C.1. 

3.3 EVALUATION OF RC2 

The second evaluation was done in M14 and it addressed the functional testing of 

RC2. The participating partners were: TU-Wien (evaluation lead), SPK (participant), 

and ECTRL (participant). Both partners agreed that the basic requirements for RC2 

were fulfilled but identified gaps in the tool‟s ability to support the user during the 

mapping process. They suggested overworking the feedback mechanism intended to 

assist the user (error and warning messages). Furthermore, they requested better 

help support during the actual mapping procedure since novice users may be 

overwhelmed by the proposed (and supported) mapping procedure. The collected 

results were presented in a review meeting. All partners agreed on the basic 

functionality but shared the obligations about the user‟s assistance. All partners 

accepted RC2 but stated that the user assistance had to be improved in the next 

release. The feedback and results had been collected and added to the list of 

requirements for the next release candidate. 

RC 2 introduces the basic functionality that will solve some of the issues raised by 

the first candidate by offering the integration extensions such as the xml and text 

editor to correct or edit the elements used in for the mapping in the same tool, and 

the infrastructure to introduce help content was introduced. Thourgh wizards the 

user could get feedback as to how to correctly upload items into the working space. 

Additionally the transformation of a final mapping file (the outcome) is with this 

release possible and the user can also preview the mapping connections in an 

integrated HTML viewer without having to actually export or finalise the whole 

project. The only problematic issue raised by this release was the non-satisfactory 

usability and feel of the graphical interface and the modelling dialogues were still too 

technical. 

The results of the evaluation are attached in Appendix B.2 - Test cases for release 

candidate 2. 

The Acceptance notes for RC2 are attached in Appendix C.2. 

3.4 EVALUATION OF RC3 

The evaluation was conducted in M21 and focused on the functional evaluation of the 

third release candidate (RC3) of the HarmoSearch mapping tool. Lead by the TU-

Wien as evaluation leader SPK (participant) evaluated RC3 with regard to the list of 

requirements collected in the previous evaluation session. SPK attested significant 

improvements regarding the usability of the mapping editor and valued the form-

based mapping as very helpful for novice users. Furthermore, the overall 

functionality of the tool improved. However, some issues remained towards the 

messaging capability of the wizard dialogs and the mapping patterns that were used 

during the evaluation. The results had been presented to all partners in the next 

review meeting. All partners accepted the release candidate. 

Usability issues were finally handled by RC 3. This candidate offered the possibility to 

use a “form viewer” which complemented the graphical interface. The time needed 



 

File: D6.3_Evaluation_Report_on_Validation_of_Results_of_Mapping_Tool Page 11 of 31 

FP7-SME-1   262289      

HARMOSEARCH                

Deliverable D6.3 

for simple mapping reduced, by means of „drag and drop‟ the items to be mapped 

and a simplification of the steps and dialogues for modelling. A new functionality also 

allowed defining certain values (such as languages) at the beginning of the mapping 

which permitted the mapping of multilingual data elements. During the development 

of this release, it became clear that in certain cases a more complex mapping had to 

be performed by a technical expert or in case a mapping project was to be 

interrupted and continued at a later time; two new functionalities were introduced 

for allowing this: visual indicators that determine the status of the mapping and the 

possibility to export a bundle file with all elements needed for continuing work in 

another mapping tool application. 

The results of the evaluation are attached in Appendix B.3 - Test cases for release 

candidate 3. 

The Acceptance notes for RC3 are attached in Appendix C.3. 

3.5 EVALUATION OF RC4 

The last evaluation was performed in month 27 (M27). Lead by Promoter (evaluation 

leader), most of the partners of the project were involved as participants, in 

particular as expert users in the first phase of evaluation of release candidate 4 

(RC4). Then, in the second phase, representatives of Museumsmedien were involved 

as domain-experts and real users.  

Once the core functionalities, extensions and the usability of the tool were 

extensively tested and evaluated, the last candidate (RC 4) focused in fine tuning 

and integration with the HarmoSearch portal. As for the fine tuning, a last 

component was developed: the mapping of referenced lists called value mapping. 

This mapping is also integrated in the main mapping file within the tool, and allows 

transmitting data that is typical of the user‟s schema.  

The last development was introduced towards the integration with the HarmoSearch 

portal. A wizard dialogue where the user can upload selected items (the outcome 

with both data and value mapping and local libraries) directly into the portal. 

The results of the evaluation are attached in Appendix B.4 - Test cases for release 

candidate 4. 

The Acceptance notes for RC4 are attached in Appendix C.4. 

3.6 EVALUATION WITH EXTERNAL DOMAIN EXPERTS 

A meeting was held by SPK with Jürgen Freundel the developer of the exhibition data 

base of the State museums of Berlin (SMB -current data provider of euromuse.net). 

He also manages the event data base of the Kunstsammlungen Karlsruhe. He is 

familiarized with euromuse.net but never used the Harmonise services before. 

The purpose of this meeting was to explain the status of the project to a museum 

and to introduce, in a more detailed way, the mapping tool.  

3.6.1 Evaluation of the functionality 

After a short presentation of the mapping tool, we initialised and took some instance 

data the State Museums of Berlin provide euromuse.net. He had comments 

respective following functionalities: 
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 The Schema: It was his opinion that it is an obstacle to require xml. In his 

opinion there are richer formats that transmit structured data better, such as: 

a php serialized array, debug or json. 

o Some php instance data here:  

http://www.smb.museum/smb/export/export_exhibition_list.php?form

at=php  

o Debug: 

http://www.smb.museum/smb/export/export_exhibition_list.php?form

at=debug   

o Json: 

http://www.smb.museum/smb/export/export_exhibition_list.php?form

at=json  

 The Filter: This element was developed to constraint the possibilities that the 

HTO ontology offers (more than just event-related fields). This element is a 

fix set of data, and there were elements omitted that could be mapped to the 

state museums data. It would be nice to be able to choose wich elements a 

user wants to map. 

 The use of local reference lists in a SKOS format: Referenced values are 

usually kept in databases that only support exporting data in csv/xml format. 

3.6.2 Evaluation of the usability 

Mr Freundel can be considered as a technical expert user, but also a domain expert, 

for he, as well, develops the content management system for the editors of the SMB 

museums. These editors are domain experts with no technical expertise, but in the 

case of the SMB museums, they are not confronted with tasks related with the 

scenarios described in this project. They have also no experience or knowledge 

about data exchange formats. 

From his point of view, a non-technical editor of SMB, will never have the capacity to 

use such services of the HarmoSearch portal.  

It is his opinion that, if the mapping tool responds, he could perform mappings if he 

was contracted to do so. And he could think of actual situations in which such a 

service would be useful. 

Since he has experience with several museum institutions, he can estimate that this 

kind of services (including the mapping procedure) could be offered to those 

museums, with an in-house database administrator. He generally thinks it can be a 

solution for those museums that already offer the possibility to export the exhibition 

data.  

 

 

http://www.smb.museum/smb/export/export_exhibition_list.php?format=php
http://www.smb.museum/smb/export/export_exhibition_list.php?format=php
http://www.smb.museum/smb/export/export_exhibition_list.php?format=debug
http://www.smb.museum/smb/export/export_exhibition_list.php?format=debug
http://www.smb.museum/smb/export/export_exhibition_list.php?format=json
http://www.smb.museum/smb/export/export_exhibition_list.php?format=json
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4 FUTURE RECOMMENDATIONS 

In this chapter recommendations for future improvements are provided. The 

recommendations are thereby based on the findings of the tool evaluations described 

in the previous chapter.  

 Issue filter to reduce hto schema. Instead of a rigid xml filter that is given, a 

possibility would be to have the possibility to choose whichever „steps‟ you 

wish selecting from a list. 

 Issue xsd, the schema is a component that is modelled from instance data, by 

inserting instance data; the mapping tool could be able to generate a schema 

without the need of other software. 

 Issue automation, the tool could be further developed regarding self-

regulation if the tool could detect repeating behavoir; such as, date time 

formats, which repeat each day of the week or that it generated a repository 

of options independent from  mapping projects, in order to make 

„suggestions‟ to users that make more than one mapping. 

 Issue usage of the mappings and integration with the portal, if a mapping file 

is well compiled and structured and there is only one misconnection, a 

mechanism is missed that identifies it. Currently, if a line of the mapping file 

has an error, it discualifies the whole operation. 
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APPENDIX A. LIST OF REQUIREMENTS 

This section contains the final list of requirements that was incrementally built and 

updated. It was used to validate the actual features of the mapping tool against the 

requirements per release. 

 



Appendix A - List of requirements for the Mapping Tool 1/1

ID Type AuthorGroup Action Requirement Description Comment Release

Implement

ed Comment for the release

RQ MH Mapping editor Mappings

Mapping tool shall support 

user in making of mappings by 

making suggestions

e.g. data fields from user's schema similar to a field from ontology are selected 

as candidates for mapping rules Will progress in subsequent releases 4 Y

RQ MH Mapping editor Mappings

Mapping tool can be used 

without any technical 

understanding of making of 

mappings but knowledge on concepts and some level of IQ must be given 1 Y

M1 RQ TS Mapping editor Mapping

Dialogue driven mapping 

(editor) user will be asked human-like questions, to define the mapping Improve according to the comments made by the users 5 Y

xxxdf: add line to improve 

wording and dialogue for 

templates likes dates or 

language

M2 RQ TS Mapping editor Mapping 

Easy implementation of 

mapping updates

The user should be able to update minor changes within the mapping according 

to the error log 3 Y

RQ TS Mapping editor Mapping

Automatic identification of 

standardardised elements like 

dates

the mapping editor can identify elements like dates, times and other repeated 

elements in a provided source (e.g. ids of special entities)

This is ongoing work so something will be possible in release 2 

(split) 2 Y

RQ MH Mapping editor Mapping trial run

Make trial run with new 

mappings

After making a mapping, the user shall be able to run a mapping with a sample 

file to test the mapping 2 Y

But need to have the 

capacity to see the result in 

HTO

RQ MH Mapping editor Mapping

The mapping tool shall 

integrate knowledge on 

making of mappings It shall provide a guide to the process, best practises for mappings, etc.

This is ongoing work so something will be possible in release 2 

(split) 2 Y Partly. This is ongoing work

RQ HS Mapping editor Mapping

Support the user in finding the 

right field

in the HTO ontology. This supposes that we can first use the annotation 

information but also that  it is likely to be extended to have a nice name, 

additional structured information… 4 Y

RQ HS Mapping editor Mapping

Allow many to one and one to 

many mapping

Like Description.Title goes to Title and Like Description.Body goes to long 

description 3 Y

RQ HS Mapping editor Mapping

Improve capacity to integrate 

new mapping based on real life schemas in different subdomains 4 Y

RQ HS Mapping editor Mapping

Integrate output mapping into 

the metasearch engine 5 Y

RQ XX Mapping editor

Transform HTO 

into output HTML

In order to display results in 

HTML 3 Y

RQ HS Mapping Interface Reference list

Be able to map list of 

references to generic lists 

supported by the portal Mapping between general lists will be performed by Harmosearch 4 Y

6 RQ IM Mapping editor settings 1

system elements (schema, 

filters, patterns…) should load 

automatically

Before the actual beginning of the mapping there are always some SETTINGS to 

decide, but if the user only parts from the own xsd, other necessary elements 

(filters, HTO schemata, patterns) should be default settings. 3 Y

8 RQ IM Mapping editor settings 3

pre-configured type of 

mapping through dialogue

maybe a pre-configured dataset could be loaded introducing an initial question 

(i.e. type of event), the fields should be then re-named or fields could be added 

in case the default "exhibition" fields are insuficient this would apply certain filters to the hto xsd schema 4 Y

9 RQ IM Mapping editor Mapping

guidance to the user while 

linking

if the links can be adjusted in the dialoge-popups, these should contain some 

information what the user is supposed to do.

the dialogs that shoud allow to define i.e. date format to the 

individual strings, were no different from those in the RC I 

tested. It is half covered with task lists. 4 Y

RQ HS Mapping editor Query mapping

Perform query mapping in the 

mapping editor This is not retainedtutorial X Dropped

Since mapping tool is too 

much behind

RQ HS Mapping editor

Reference list 

mapping

Perform mapping of reference 

lists 

Could be within the editor or triggerred by the editor and performed in a web 

application 4 Y

RQ HS Mapping editor

Wording and 

templating

Improve wording for the helps 

and the items in thee list + 

add capacity to reuse previous 

mapping

value-of to change into something more user freindly, like mapping of langauge 

dependent items or opening hours: do it once and they have something in a list + 

reuse 5 Y

Partial. Could still be 

cgreatly imporved
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Id Parent Action Name Description

Comment

 (and alternatives) 2
0

/0
9

/2
0

1
1

W
h

o

Actual Result

MT1 Mapping Tool RCP Start mapping application

Used to test if the mapping tool  starts as 

expected from a Windows-based application.

Output: The application should come up as expected from a common Windows application (start). By clicking the X or the menu item 

"Exit" (File menu) the application windows should dissapeare accordingly (exit). 

W IM In the location D:\HARMOSEARCH\06_Mapping 

Tool\Flocke_rc1_.win32.win32.x86 the application did not react. 

Changed to C/temp/flocke and works 

Additional comment: After finishing the test cases I was not able to 

close the mapping tool accordingly. 

MT2 MT1 Mapping Tool RCP

Customize mapping tool 

application window

The user is allowed to make changes to the 

mapping tool interface. This regards to 

appearance related issues such as for example 

window size, open views, position of a view 

within the tool, etc. For testing purposes the 

user is required to change the window size and 

the location of a view by simply drag-and-drop.

Output: The tool reacts according to the changes and displays the view within ist new position and the application window is resized 

accordingly.

O IM

Worked as expected

MT3 MT2 Mapping Tool RCP Exit mapping application

Used to test if the mapping tool can be exited 

as expected from a Windows-based application. Output: The application is terminated as expected from a common Windows-based application.

O IM

Worked as expected

MT4 MT2 Mapping Tool RCP Auto-apply customiziations

Evaluates if the changes done in Task MT2 are 

committed and executed to the mapping tool. Output: The excepted behaviour (see MT2) is still valid after the mapping tool application has been restarted (see MT1 and MT3).

O IM

Worked as expected

MT5 MT1

Mapping Project 

Handling

Create a clean mapping 

project

Clean mapping projects are used to denote 

mappings that are not realted to any kind of 

business case (e.g. Euromuse business case). 

Accordingly, no default resources, such as 

Schema, Filter, or Patterns are associated and 

therefore not included in the project from 

scratch. 

Output: The new mapping project is created reflecting the initial project structure. The project structure is visible in the project 

explorer window in the mapping tool as well as locally in the file system. Thereby, the project root is a folder, which name must be 

equal to the project name as specified by the user. The root folder has to include the following folders: Filter, Mappings, Output, 

Pattern, Schema, as well as a configuration file named config.xml.

O IM

Worked as expected

MT6 MT1

Mapping Project 

Handling

Create a profile-based 

mapping project

Profile-based mapping projects are business 

case specific (e.g. Euromuse) and therefore 

include distinct resources (Schema, Filter, 

Patterns, etc.). A profile summarized the 

included resources.

Output: The new mapping project is created accordingly (see MT5). In contrast to MT5 the folders are now filled with corresponding 

resources. Again, this can be observed directly in the mapping tool (project explorer) as well as locally in the file system. Since the 

project has been created using the Euromuse profile the following resources have been added to the corresponding folders: 

eurmouse_filter.filter, hto_filter.filter (both to the Filter folder); hto.xsl, HTO_Euromuse.xsl (to the Pattern folder); hto.xsd (Schema 

folder).

O IM

Worked as expected

MT7

Mapping Project 

Handling Open/Close schema file

Schema files are formalized using an XML 

notation. Thus, it makes sense to open a 

schema file for editing purposes within the 

mapping tool. 

Output: By double-clicking on a schema file (visible in the project explorer) an XML editor opens and displays the content of the file. 

In case the schema file is corrupt or not valid (e.g. not well formed) a corresopnding error message is presented to the user. The 

editor-window is closed by clicking on the "X" button in the upper right corner. 

O IM

Worked as expected

MT8

Mapping Project 

Handling Open/Close pattern file

Patterns are XSL templates that transform a 

given input to a given output. In addition 

patterns need to be adapted from case to case. 

Accordingly, the mapping tool needs to allow a 

technical user to open and change a pattern.

Output: By double-clicking on a pattern file (visible in the project explorer) an XSL editor opens and displays the content of the file. In 

case the pattern file is corrupt or not valid (e.g. not well formed) a corresopnding error message is presented to the user. The editor-

window is closed by clicking on the "X" button in the upper right corner. 

O IM

Worked as expected

MT9

Mapping Project 

Handling Open/Close filter file

Filters are simple expressions that put a schema 

into a strict corset. In order to edit a filter it is 

necessary to open the filter within a text editor.

Output: By double-clicking on a filter file (visible in the project explorer) a text editor opens and displays the content of the file. In 

case the pattern file is corrupt a corresopnding error message is presented to the user. The editor-window is closed by clicking on the 

"X" button in the upper right corner. 

O IM

Worked as expected
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Actual Result

MT10

Mapping Project 

Handling

Create new mapping model 

file

In some situations a single mapping file may not 

be suitable. Therefore, the mapping tool has to 

be capable of handling an arbitrary number of 

mapping files. Accordingly, it has to provide an 

adequate mechanism that allows the user to 

create new mappings from scratch. Output: The newly created mapping file is created locally and added to the Mappings folder (visible in the project wizard). 

O IM

Worked as expected

MT11

Mapping Project 

Handling Import local schema file

In most cases the user wants to make a 

mapping from his private data schema to the 

Harmonise data schema. Thus, he needs to add 

and open his proprietary schema in the 

mapping tool.

IM: Select Import Schema. The pop up menu had the option “import…” and I clicked that, another window appeared 

Output: The newly imported schema file is added to the project and added to the Schema folder in the project structure (both, locally 

on the file system as well as in the project explorer of the mapping tool). In case the schema file is corrupt or another exception 

occurs the tool reacts in two ways: First the user will be notified that an error occurred and second a new log message is added to the 

log file.

W IM

I was able to accomplish the task, but only at the second try. Calling 

the wizard was confusing due to missleading wording (see comment).

MT12

Mapping Project 

Handling Export mapping project

Exporting a mapping project allows users to 

share solutions and collaborative work on 

mappings. 

Output: Results in a ZIP file that can be saved locally. The ZIP contains all necessary meta-information and resources. Accordingly, the 

resulting ZIP contains the project structure and all associated resource-files (e.g. pattern, filter, mappings, schema)

O IM

Worked as expected

MT13

Mapping Project 

Handling Delete mapping project

The mapping tool needs to be capable of 

deleting a mapping project, which is currently 

not used but should be kept for further tasks.

Output: The mapping prjoect is deleted from the project explorer. However, not entirely from the local disc. Consequently, the 

project folder and ist subfolders (including resources) is still available.

O IM

Worked as expected

MT14

Mapping Project 

Handling

Permanently delete a 

mapping project

Some mapping projects are of no use any more. 

Accordingly, the mapping tool has to provide a 

delete option that allows the user to 

permanently remove a project (both locally and 

from the workspace).

Output: The mapping project is deleted from the project explorer and locally from the file system. As a result the project is not visible 

in the file system.

O IM

Worked as expected

MT15

Mapping Project 

Handling Import mapping project

To collaborate/extend existing mapping 

solutions.

Output: Uses the exported project (ZIP file) from MT12. A wizard guides the user trough the import process where he has to provide 

the location of the target project ZIP file. After all information has been provided the project is visible in the project explorer and the 

local file system. In case of an error a user notification by means of a dialog is shown and a new log message is added to the log file. 

O IM

Worked as expected

MT16

Mapping Project 

Configuration

Open/(Clode configuration 

file editor Allows users to edit the current profile.

Output: After double-clicking the configuration file (visible in the project explorer) a configuration editor opens. In case of an error 

(e.g. not well formed) the editor wont open. Instead a corresponding error message is prestented and displayed to the user. 

O IM

Worked as expected

MT17

Mapping Project 

Configuration Add/Remove schema file

Adds or removes a schema from the profile and 

the project.

Output: By checking a schema (and savind the changes) the corresponding file is added to the project explorer. The new file is 

present in the Schema folder. Removing a file is similar: Uncheck the box and save your choice. The schema file will be removed from 

the project structure (schema folder). 

O IM

Worked as expected

MT18

Mapping Project 

Configuration Add/Remove pattern file

Adds or removes a pattern from the profile and 

the project.

Output: By checking a pattern (and savind the changes) the corresponding file is added to the project explorer. The new file is present 

in the Pattern folder. Removing a pattern is similar: Uncheck the box and save your choice. The pattern file will be removed from the 

project structure (pattern folder). 

O IM

Worked as expected

MT19

Mapping Project 

Configuration Add/Remove filter file

Adds or removes a filter from the profile and 

the project.

Output: By checking a filter (and savind the changes) the corresponding file is added to the project explorer. The new file is present in 

the Filter folder. Removing a filter is similar: Uncheck the box and save your choice. The filter file will be removed from the project 

structure (Filter folder). 

O IM

Worked as expected

MT20 Graphical Modeling Open/Close editor

To conduct mappings a graphical editor is 

necessary. This editor is called only on mapping 

files. 

Output: The mapping editor is opened by double-clicking a mapping file (Mapping folder). As a result the grahpical editor opens and 

presents an empty canvas (in case the mapping file has been empty) or an already existing mapping. In case the file is corrupt or 

damaged the editor wont open corretlcy. Instead a corresponding error message is displayed. 

O IM

Worked as expected

MT21 Graphical Modeling Load schema to editor

Schemata are the actual subject of mapping 

and need to be present in a mapping file.

Output: A schema file is deliaged to open within the graphical editor by drag-and-drop the schema file from the project explorer to 

the already opened editor (see MT20). As a result the schema is opened and displayes accordingly in the editor. In case the user 

wants to drag-and-drop files others than schema files (*.xsd extension) the drag operation will not work. In such a case the drag 

coursor provides visual feedback (crossed cicle) to the user.

O IM

Worked as expected
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MT22 Graphical Modeling Move schema figure

Already loaded schemata need to be moveable 

in order to keep the editor window usable.

Output: The user is able to move a loaded schema by simple drag-and-drop operations within the editor. As a result the schema can 

be moved smoothly within the editor window and changes its position according to the user's mous position.

W IM
Was able to meet expectations. However, some issues are left. The 

window in the editor’s area of the schema seems to be resizable (and 

it works vertically) but horizontally it won’t expand / shorten (okv.xsd 

has some long tag names

MT23 Graphical Modeling

Tree interaction 

(collapse/expand) Output: By clicking the + respectively - buttons near a node the tree can be collapsed or expaned.
O IM

Worked as expected

MT24 Graphical Modeling Load second schema Output: A second schema file is loaded to the editor and visualized as a tree structure (see MT21).
O IM

Worked as expected

MT25 Graphical Modeling

Perform simple mapping 

(connect elements)

In general a user can perform two types of 

mappings: Simple and complex types. The 

former correspond to mappings that connect 

two atomic elements (with no further children 

nodes), whereas the latter corresponds to 

mappings that describe the linking between 

elements that have further children.

Output: A connection between two simple elements is visualized. Therby, the connection is drawn as a line leading from one schema-

element to its opposite. The opposite is thereby, located in a another schema tree.

O IM

Worked as expected

Additional comments: 

What if I connect two elements that make no sense? It makes the 

connection, I can correct with the select tool the end of the link and 

place it in the correct place, this action was not in the task list.

When mouse over the link a pop up info window (yellow) appears, 

but this appears very far from the mouse, this should appear where 

the mouse is.

MT26 Graphical Modeling Delete mapping links

Output: Pressing the delte button on the keyboard or via a left-click on the connection the line bewteen the two elements is erased. 

As a consequence the line is not visible anymore.

O IM
Worked as expected

Additional comments: 

The option “Delete proposal” in the upper frame of the editor area is 

not irreversible!! I clicked it thinking it would be deleting only 1 link 

but it deleted all my links at once without telling me that all my links 

would be irreversibly deleted.

MT27 Graphical Modeling Perform complex mapping Output: Draws a connection (see MT26) between two complex elements (parent elements) of two distinct schemata.

O IM
Worked as expected

Additional comments:

IM: Suggestion for the list: Couldn’t it by clicking on the elements to 

be linked themselves also activate the link pop-up (the lines are hard 

to click sometimes, specially when 2 lines run together 

MT28 Filters

Call filter dialog (select 

all/deslect all/select single 

filter) Allow the user to apply or delete certain filters. Output: By clicking the + respectively - buttons near a node the tree can be collapsed or expaned.

O IM

Worked as expected

MT29 Filters

Apply specific filter to 

schema

Output: The target schema is constrained to the elements that are defined in the filter. Accordingly, the hto schema is constrained to 

event related information items.

O IM
Worked as expected

Additional comments:

Once applied the filter I cannot undo it. If I click undo, the last action 

performed in the editing area (a link was set) undoes. 

MT30 Filters Add another filter to schema Allow multiple filters at a time.

Output: Within the filter dialog another filter has to be clicked and committed (by clicking OK). The behaviour follows the same as 

described in MT29.
O IM

Worked as expected

MT31 Filters Clear all filters Delete all filters from the mapping.

Output: Removes all checked filters in the filter dialog. After clicking the OK button the changes are reflected by a "reset" in the 

mapping editor.
O IM

Worked as expected
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MT1 Import Import 

A user imports an existing mapping project 

solution pakced within a ZIP file. 

MT1.1 MT1

Call import 

project wizard Import project 

The user calls the import project wizard that 

allows him to select an existing ZIP file from 

the local file system. 

The chosen mapping project is imported from the source location (local file system) to the current workspace. The mapping project 

and ist contents (e.g. patterns, filters, schemata) are (after the import) available in the workspace. Furthermore, the data is also 

copied "physicall", meaning that all files and folders are also available in the workspace folder on the local file system. 

o TM

worked as expected; used 

the museolito project as 

provided by Albert Rainer

o IM

worked as expected

MT2 Mapping Mapping

A user is able to perform simple or complex 

mappings using the HarmoSearch mapping 

editor.

MT2.1 MT2

Import schema 

to editor

Import schema to 

editor

In order to create a mapping it is necessary 

that the user is able to import a 

corresopnding schema to the mapping 

editor.

The schema resource is a schema (xsd) file located in the current mapping project. Schema resources are located in the project's 

"Schema" folder. To import the file to the mapping editor the user has to click on the schema file, holding the click and dragging the 

file onto the mapping editor. As a result the schema (and its elements) are displayed as a tree structure in the mapping editor.

o TM

worked as expected

o IM

worked as expected

MT2.2 MT2 Apply filter Apply filter

Filters are used to constrain the visibility of 

schema elements that are not relevant for an 

individual mapping case. 

Filters are resources that are captured in the "Filter" folder of the mapping project under consideration. A filter can be applied to a 

mapping by opening the mapping file in the mapping editor and clicking the "applyFilter" button on the main toolbar. A dialog pops up 

and provides the user the possibility to select the filers of choice. In case the user has chosen filters before the corresponding ones 

are already marked as active (check beside the filter). As a result the visible elements of the target schema (ech filter is used to have 

at least one target schema) is reduced to all those elements that are not filtered.

o

Worked as expected

o IM

worked as expected

MT2.3 MT2

Create initial 

mapping

Create initial 

mapping

The user is able to conduct a graphical 

mapping by connecting source and target 

elements of the source respectifely target 

schema.

The user is able to create a mapping by specifying the elements that should map. Therefore he opens the mapping editor by doule-

clicking on the mapping file (located in the "Mapping" folder) and importing the source and target schemata. To associate two 

mapping candidates the user has to select the "link" component placed on the toolbar (left hand side of the editor). The connection is 

drawn by drag and click on, first the source element, and second the target element. As a result a black link between those elements 

is drawn.

o

worked as expected

o IM

worked as expected

MT2.4 MT2.3

Refine mapping 

and apply 

pattern

Refine mapping 

and apply pattern

The user performs a mapping by applying a 

pattern.

Click on the “select” element of the palette to enter the “select modus”, then click on the newly created link.  A dialogue will open. It 

shows a list where one can select suitable pre-built methods from the support libraries. As a result the link between source and target 

element changes its color to green. 

o

worked as expected

o IM

worked as expected

the pattern windows are still very uninformative

MT3.1 MT3

Create XSLT 

transformation 

file and gain 

visual feedback Create XSLT transformation file and gain visual feedback

After solving a specific mapping scenario the 

user is able to transform the mapping to an 

adequate transformation format (e.g. XSLT). 

Press the “createTX” (TX is for transformation) in the action bar. This triggers the transformation process 

provided by a transformation engine instance file. Transformation process files are stored in the "Input" 

folder and can contain an arbitrary number of transformation steps (e.g.transform the mapping to 

harmonise, harmonise to euromuse, and euromuse to a HTML representation). At the end of the 

transformation process the HTML output (currently set as default) is shown in the internal feedback view. 

The feedback view pops up automatically.

w

I had to manually change 

the support library 

references; may be to 

complex for a "simple" 

domain expert. Beside 

that it worked as expected

w IM worked as expected; I had to manually correct and edit the XSLT and have to 

say that it was very complicated and not so clear

after completing some more links: the html preview filled … . A question 

remainted, if I import the other reference lists available, shouldn't the html 

view read the new xslt files? Or do they have to be linked?

URLS: I could not test the 'en' url because museolitto does not provide links to 

the exhibition page in English

Images:This element has no match in the hto ontology (filtered), had to be 

added manually by Albert

Prices & Categories: Museolitto does not provide this kind of information 

(museoliitto provides this infromation in other field from other table, it is not 

necessary).

Permanent: It is not so important, if an exhibition has an end data, it is 

temporary. At the moment we only receive from museolitto temporary 

exhibitions, so all entries have this field empty

the outcome, as i very well asked in my presentation and before, the output 

mapping file did not work on the server, is it not necessary that i can output a 

file that works in order to validate? If I recall correctly from my output file to 

the mapping file uploaded in the server (which works) there are two 

differences: the image pattern was manually added, so was a path at the 

beginning of the file.

MT4 User assistance User assistance

Refers to relevant enhancments helping the 

user handling the mapping tool
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MT4.1 MT4

Automated 

update Automated update

Tool updates and realeases should be 

installed minimal invasive from a user's 

perspective.

The automatic update is executed after starting the mapping tool. In the background the update component of the mapping tool 

checks the available repositories if new plugin versions are available or not. In case they are the mapping tool displays a dialog guiding 

the user through the update process. Otherise a dialog appears that informs the user that no updates were found. The latter case has 

no effect and the user is able to proceed using the mapping tool. In the former case he be asked to restart the mapping tool in order 

to apply the changes and make the new updates available in the mapping tool (e.g. add help, menu, alternative editor, etc.) 

o

worked as expected

x IM

After starting the tool it was stuck for nearly 10 minutes. After these 10 minutes 

a dialog reporting: 'Contacting Software Sites' has encountered a problem. 

Unable to conecto to repository … . After reporting this issue to Thomas he 

disabled the auto-update and I was able to start the editor. 

A manual update resulted in the same behavior and afterwards the tool took 

longer to start.

MT4.2 MT4

Add third party 

extensions Add third party extensions

The user should be able to extend the 

mapping tool by third party plugins (e.g. 

editors, transformation routines, etc.)

o

worked as expected

x IM

??

MT4.3 MT4.1 Integrated help Integrated help

Help supporting the user handling the main 

functionalities of the mapping tool. 

In case the user is stuck or wants to know more about specific functionality he is able to call the integrated help-documentation. To do 

so he has to select "Help->Help Contents" from the main menu. After clicking Help Contents a separate window appears showing the 

documentation separatly.

o

worked as expected

x IM

No help content (used Cheat Sheets)

MT4.4 MT4.2

Cheatsheet 

support Cheatsheet support

Neat process descriptions in a tutorial-like 

way.

In order to use cheatsheets the user has to go to "Help->Cheat Sheets…". A dialog appears listing all available cheatsheets. After 

selecting the desired cheatsheet a separate view opens and displays the cheatsheet's content providing a step-by-step description of 

how to reach a specific goal (e.g. create a new mapping project). In addition the cheatsheets are supported by help and wizard 

support.

o

worked as expected

o IM

worked as expected

I consider these cheatsheet approach as very helpfull

MT4.5 MT4.1

Context-

sensitive help

Context-sensitive 

help

Provides the ability to show context-sensitive 

help as a hook to the integrated help 

(documentation). 

Context-senstive help can be retreived in two ways: (i) by pressing the F1 button or by clicking the question mark button within a 

dialog (e.g. wizards, cheatsheets). In both cases a short summary message is displayed in the help view (which might come up). The 

contextual help points the user to additional resources (often pinpointed under "see also:").

o

worked as expected

x IM
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MT0 Test Preparation How to install the mapping tool from scratch

MT0.1 MT0

Download 

current version

Download current 

version

Prerequisite: You have access to the Internet and are 

allowed to download files

Download the mapping tool

- go to http://goo.gl/8Sial

- download the lattest mapping tool version

- enter user name (harmosearch) and password 

(harmosearch123)

Expected result

- Setup file on your local hard disk o

TM
 (TU

-W
ien

) o

IM
 (SP

K
)

MT0.2 MT0

Install the 

mapping tool 

Install the 

mapping tool

Installation of the mapping tool to your local hard drive

- start the setup and follow the wizard instructions

- accept the license agreement (currently not specified)

- specify the install location on your local hard drive (e.g., 

C:\Harmosearch)

Expected result

- new directory corresponding to the provided installation location during 

installation

- new icon on the desktop 'MappingTool' o

TM

o

IM

Installed correctly

direct access in desktop was created :D

MT0.3 MT0

Start the 

mapping tool

Start the mapping 

tool

Prerquisite: You have installed the mapping tool 

accordingly

Start the mapping tool

- double-click the 'MappingTool' shortcut on your Desktop

Alternative: Open the tools installation location; Start 

the mapping tool by double-clicking the 

MappingTool.exe

Expected result

- mapping tool window appears o

TM

o

IM

MT0.4 MT0

Remove the 

mapping tool

Delete the 

mapping tool

AT THE END OF YOUR TESTING

Uninstall the mapping tool

- open the tools installation location 

- double-clicking "uninstall.exe"

- follow the instructions of the uninstaller 

NOTE: The uninstaller in its current version is kept 

very simple and stupid. Thus, the uninstallation 

procedure will delete ALL data in the respective 

installation location!

Expected result

- mapping tool has been uninstalled from the local hard disk

- desktop icon "MappingTool" has been deleted w

TM

The installer needs to be 

refined for the final release 

since in ist current state it 

deletes all the content from 

the installation directory. This 

may be OK in case the tool 

has been installed within an 

isolated location, but causes 

a lot of trouble if not, e.g., 

installed on C:\ x

IM

Like in the previous version of the mapping 

tool, the complete status bar is after a click 

full, and it does not unistall anything.

MT0.5 MT0

Update the 

mapping tool

Update the 

mapping tool

Prerequisite: You need to have access to the Internet and 

the mapping tool needs to have firewall permission to 

download content; Mapping tool started and running

Install updates

- go to Help > Check for Updates

- follow the instructions

- restart the mapping tool

In case no updates can be found a respective 

information is shown to the user: "No updates were 

found"

Expected results

- Update is beeing processed and installed

- at the end of the installation process a dialog appears asking wheather 

to restart the application or not o

TM

w

IM

is there a way around the firewall (i cannot 

change my firewall settings, and these do 

not allow the mapping tool to connect).

Alternatively you could ask Adriano or 

David (or Peter) to do these test lines?

MT0.6 MT4

Add third party 

extensions

Add third party 

extensions

Prerequisite: You need to have access to the Internet and 

the mapping tool needs to have firewall permission to 

download content; Mapping tool started and running

Alternative: Install plugins from a ZIP resource (see 

Alternatives)

Add a third party extension

- go to Help > Install New Software

- select 

http://www.ec.tuwien.ac.at/projects/harmosearch/mappin

gtool/repository" from the drop-box 

- expand "HarmoSearch - Third Party Features 

- check "HarmoSearch Mapping Tool Cheatsheets" 

- press "Next" and follow the instructions

- restart the mapping tool

Alternative:

Install updates from ZIP resource

- Click Help > Install New Software

- Click "Add…"

- Click "Archive"

- Navigate to the test data folder (data_tool) and select 

"Flocke_Additions_Cheatsheet_Support.zip"

- Click "OK"

- Enter "Cheatsheet Support" in the "Name" field

- Click "OK"

- Uncheck "Group Items by Category" 

- Check "HarmoSearch Mapping Tool Cheatsheets"

- Click "Next" and follow the instructions

- Restart the mapping tool

Expected results

- Third party plugin is updated and processed

- At the end of the installation procedure a dialog appears asking you to 

restart the mapping tool

- After restarting the mapping tool an additional menu entry should 

appear under the Help main menu entry

- Click "Help > Cheatsheets …" 

- A dialog appears and displays HarmoSearch related contents

- Expand  "HarmoSearch" and make sure it contains two entries (i) "Create 

a new "Hello World" mapping project" and (ii) "Reuse existing mapping 

solution" o

TM

Worked as expected w

IM

is there a way around the firewall (i cannot 

change my firewall settings, and these do 

not allow the mapping tool to connect).

Alternatively you could ask Adriano or 

David (or Peter) to do these test lines?

MT1 Typical functionality for a solution developer
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MT1.1 MT1

Create new 

project

Create new 

project

Create a new mapping project

- go to File > New > Mapping Project

- provide a project name and a mapping file name (set per 

default)

- press "Finish"

Input validation project name

- provide no project name

- an error message is displayed at the top of the wizard 

dialog: "Provide a correct project name."

Input validation mapping file name

- provide a project name

- delete the default name of the mapping file

- error message appears: "Provide a correct mapping file 

name."

- enter a file name, without file ending ".harmonize"

- error message appears: " The mapping file has to have 

the extentension harmonize"

Expected result

- a new project appears in the mapping navigator view

- the project contains 6 folders, i.e., Filter, Input, Mappings, Output, 

Pattern, Schema

- the project contains a configuration file, i.e., basic.mappingconfig

o

TM o

IM
as expected

MT1.2 MT1

Feedback 

regarding the 

new project 

wizard

Provide feedback 

about the content 

and the 

appearance of the 

new project 

wizard. 

Typical questions under consideration may be

- is the information provided by the dialog sufficient

- is the presented information easy to understand and self-

explaining

- is the feedback in case of an error sufficient

IM

 - If you have chosen New>Mapping 

project there is not much dialogue 

 - having the red cross, when the user has 

not yet entered a name to the mapping 

project, leads to think that something is 

already wrong, maybe only a warning sing 

(pic warning.png)?

 - Of course, if the user modifies the file 

that has to end .harmonise, the red icon 

should appear. For "harmonise" is not a 

common extension, maybe write 

".harmonise" with "."?

w
arn

in
g.p

n
g

MT1.3 MT1

Import schema 

wizard Import schema 

Prerequisit: An already existing mapping project

Import a schema resource

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Schema File" 

- check "Choose an existing file from local source"

- click "Browse" and navigate to the data folder (data_tool) 

and select "hto.xsd"

- select the target project

- click "Finish"

Import a schema resource from a bundle

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Schema" 

- check "Choose a bundle of files packed in a ZIP file"

- click "Browse" and navigate to the data folder 

(data_tool) and select "schemaBundle.zip"

- uncheck "KHM.xsd" (optional)

- select the target project

- click "Finish"

Expected result (single import)

- the "Schema" folder of the target project contains the "hto.xsd" schema 

file

Expected result (bundle import)

- the "Schema" folder of the target project contains "museolito.xsd" and 

"KHM.xsd"

o

TM o

IM

both as expected

MT1.4 MT1

Import pattern 

wizard

Import pattern 

wizard

Prerequisit: An already existing mapping project

Import a pattern resource

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Pattern File" 

- check "Choose an existing file from local source"

- click "Browse" and navigate to the data folder (data_tool) 

and select "date-time.xsl"

- select the target project

- click "Finish"

Import a pattern resource from a bundle

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Pattern" 

- check "Choose a bundle of files packed in a ZIP file"

- click "Browse" and navigate to the data folder 

(data_tool) and select "patternBundle.zip"

- select the target project

- click "Finish"

Expected result (single import)

- the "Pattern" folder of the target project contains the "data-time.xsl" 

pattern file

Expected result (bundle import)

- the "Pattern" folder of the target project contains multiple pattern files, 

i.e., data-time.xsl, Euromuse-RL-languages.xslt, euromuse2html.xsl, 

HTO_Euromuse.xslt, HTO_Euromuse_new.xslt, hto2html.xsl, thov2.xsl

o

TM o

IM

both as expected

MT1.5 MT1

Import filter 

wizard

Import filter 

wizard

Prerequisit: An already existing mapping project

Import a filter resource

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Filter File" 

- click "Browse" and navigate to the data folder (data_tool) 

and select "filter.xml"

- select the target project

- click "Finish"

Expected result

- the "Filter" folder of the target project contains "filter.xml"

o

TM o

IM

as expected

pics_R4/warning.png
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MT1.6 MT1

Import input file 

wizard

Import input file 

wizard

Prerequisit: An already existing mapping project

Import a input resource, e.g., instance data

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Input File" 

- click "Browse" and navigate to the data folder (data_tool) 

and select "biellaEvents.xml"

- select the target project

- click "Finish"

Import an infput file resource from a bundle

- go to File > Import

- expand "HarmoSearch Wizards"

- select "Import Input File" 

- check "Choose a bundle of files packed in a ZIP file"

- click "Browse" and navigate to the data folder 

(data_tool) and select "inputBundle.zip"

- select the target project

- click "Finish"

Expected result (single file)

- the "Input" folder of the target project contains a new file called 

"biellaEvents.xml"

Expected result (bundle)

- the "Input" folder of the target project contains 3 new files called 

"biellaEvents.xml", "biella2hto.xml", and "process.xml"

o

TM o

IM

both as expected

MT1.7 MT1

Feedback 

regarding the 

file import 

wizards

Feedback 

regarding the file 

import wizards, 

which are in 

puarticular 

pattern, schema, 

input file wizard

IM

The import wizard has 2 selections (from 

single file and from zip) this is clear, but it 

has a compulsory second step, that is not 

that clear, namely to select the target 

folder / project in which the elements are 

to be imported. 

Maybe if a warning sign where shown in 

the upper part of the wizzard (as when 

something is wrong) with the message 

"Don't forget to select the target project" 

would be more clear

MT1.8 MT1

Feedback 

regarding the 

filter file import 

wizard

Feedback 

regarding the filter 

file import wizard

IM

The import wizard has 2 selections (from 

single file and from zip) this is clear, but it 

has a compulsory second step, that is not 

that clear, namely to select the target 

folder / project in which the elements are 

to be imported. 

Maybe if a warning sign where shown in 

the upper part of the wizzard (as when 

something is wrong) with the message 

"Don't forget to select the target project" 

would be more clear

MT1.9 MT1 Export Export project

Prerequisit: An already existing mapping project

Exporting a project

- go to File > Export

- select "Archive File" and press "Next"

- check the project to be exported from the tree view on 

the left hand side

- make sure all folders are checked

- click "Browse" and select the target location on your local 

hard-drive

- select "Save in zip format"

- select "Create directory structure for file"

- (optional) check "Compress the content of the file"

- press "Finish"

Expected result

- a new ZIP file has been created in the specified location on your local 

hard-drive

o

TM o

IM

as expected

MT2

Typical 

functionality for 

domain experts Describes typical scenarios a domain expert faces during the mapping cycle using the HarmoSearch mapping tool and the Graph View mapping editor

MT2.1 MT2

Import test 

project into 

workspace

Import test project 

into workspace

Import a pre-defined mapping project 

- go to File > Import 

- expand "General" 

- select "Existing Projects into Workspace" and click "Next"

- select "Select archive file" (default)

- click "Browse" and navigate to data folder (data_tool) and 

select "BiellaDemoProject.zip"

- check "BiellaDemoProject"

- check "Copy project into workspace"

- press "Next"

Project already exists in the workspace 

(BiellaDemoProject)

- left-click "BiellaDemoProject" in the Mapping 

Navigator view

- click "Delete"

- check "Delete project contents on disk (cannot be 

undone)

- click "OK"

- repeat "Import a pre-defined mapping project"

Expected result

- a new project appears in the Mapping Navigator view called 

"BiellaDemoProject"

- expand the project

- make sure the project has a "basic.mappingconfig" file

- the following folders have to be present: "Filter", "Input", "Mapping", 

"Output", "Pattern", "Schema"

- the folders contain several files, e.g., filter.xml (Filter folder), hto.xsd 

(Schema folder)

o

TM o

IM

A) "select archive file" is not set as default, 

"select root directory" is.

B) check copy project into workspace is not 

an option (it is defaulty checked and 

greyed, check pic "import_dialogue.png")

im
p

o
rt_d

ialo
gu

e.p
n

g

pics_R4/import_dialogue.png
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MT2.2 MT2

Opening the 

mapping file

Opening the 

mapping file

Open the mapping file

- in the Mapping Navigator view expand 

"BiellaDemoProject"

- expand the "Mapping" folder

- double-click "biella.harmonize"

Expected result

- the mapping file will be opened by the maping editor (the editor 

window appears in the middle of the screen)

- the Graph View editor tab is active (highlighted)

- the modeling canvas is empty (white area)

o

TM o

IM

MT2.3 MT2

Import a 

schema to 

editor

Import a schema 

to editor

Import a schema to the editor

- expand the "Schema" folder

- click and drag "hto.xsd" onto the modeling canvas (white 

area)

- drop "hto.xsd" onto the modeling canvas

- select "event" from the drop-box and press "OK"

- click and drag "biella.xsd" onto the modeling canvas 

- drop "biella.xsd" onto the modeling canvas

- select "eventList" from the drop-box and press "OK"

Expected result

- two schema figures are shown on the modeling canvas

- the schema items are shown as tree-view 

- the shapes can be moved by simple drag and drop actions

o

TM

wokred as expected; HTO was 

filtered correctly

o

IM

I LIKE THIS!

Here is what I missed in Mint in this step, 

maybe possible to mend in flocke: define 

root element: "your schema root element 

contains one or more datasets with 

identical structure"

MT2.4 MT2

Feedback about 

the import 

functionality

provide feedback 

about the import 

functionality in 

general

IM

Provided this approach will be given once 

the user has already perfomed an initial 

mapping, or continues the work of a 

colleage, it is very simple and user-friendly 

.

All other possibilities of importing an 

existing file (Browse root element…) are 

not covered by testcase, what are they for?

MT2.5 MT2

Single source 

target mappings

Single source 

target mappings

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Map a single source element to single target element and 

accept its value

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "title" in the "biella" schema

- click on "mainTitle" in the "hto" schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- click on the newly created link

- select "hto:value-of" in the dialog 

- enter "." (without ") for the value parameter

- click "Confirm"

- save changes by clicking the save-button in the main 

toolbar

Alternative: 

- save the mapping file by pressing STRG + S

Expected result

- as soon as the mapping link is created a black line appears connecting 

both elements

- when selecting a link a dialog window appears

- confirming the mapping settings changes the color from black to green

o
TM o

IM

some kind of information in pop up that 

MT2.6 MT2

Perform 

transformation

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Make sure potential changes on the mapping have been 

saved! 

- changes are indicated by means of a * symbol at the 

top of the editor pane

Expected result

- the Feedback View appears on the right hand side of the modeling 

canvas

- the Feedback View shows 4 events in the HTO format, which is the 

output of the transformation (XSLT)

- each event (starting with <event>) has a <mainTitle> tag

- the elements "mainTitle" has a value: Mostra for the first three events, 

Mostre for the last event

NOTE: The values differ due to the provided instance data!

o

TM o

IM

expected
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MT2.7 MT2

Single source to 

multiple target 

element 

mappings

Single source to 

multiple target 

element mappings

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Map a single source element to multiple target elements 

and accept its value

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "title" in the biella schema

- click on "subTitle" in the hto schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- select the newly created link

- select "hto:value-of" in the dialog 

- enter "." (without ") for the value parameter

- click "Confirm"

- save changes by clicking the save-button in the main 

toolbar

Expected result

- as soon as the mapping link is created a black line appears connecting 

both elements

- when selecting a link a dialog window appears

- confirming the mapping settings changes the color from black to green

o

TM o

IM

expected

MT2.8 MT2

Perform 

transformation

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- each event (<event>) has an additonal <subTitle> entry

- the value for each sub title has to equal the main title's value, i.e., 

Mostra for the first three, Mostre for the last event

NOTE: The values differ due to the provided instance data!

o

TM o

IM

expected

MT2.9 MT2

Concatination 

multiple source 

to single target 

mapping

Concatination 

multiple source to 

single target 

mapping

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Concatinate values from multiple source to single target 

element

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "articleName" in the "biella" schema

- click on "shortDescription" in the "hto" schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- select the newly created link

- select "hto:value-of" in the dialog 

- enter "." (without ") for the value parameter

- click "Confirm"

- select the "link" component from the component list next 

to the modeling canvas

- click on "contactWeb" in the "biella" schema

- click on "shortDescription" in the "hto" schema

- select the newly created link

- select "hto:value-of" in the dialog 

- enter "." (without ") for the value parameter

- save changes by clicking the save-button in the main 

toolbar

Expected result

- two configured (green) mapping links interlinking the elements 

"articleName" and "contactWeb" in the biella schema to 

"shortDescription" in the hto schema

o

TM o

IM

as expected

MT2.10 MT2

Perform 

transformation

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- a new <shortDescription> element appears 

- its value contains the article title and a web link, e.g., 

Mostrahttp://www.biellesitessitoridiunita.it

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

why not with comma space inbetween, it 

makes sense to want to have 2 data in one 

field (I would imagine, e.g., I would like to 

send data that is not in the hto ontology to 

a third party (e.g. euromuse), like the 

webcontact, and I want to add it to the 

long description, but comma separated, or 

even in a new line <br/>
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MT2.11 MT2 Date mapping Date mapping

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Map an xsd formated date

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "dateMin" in the biella schema

- click on "startDate" in the hto schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- select the newly created link

- select "hto:xsd-date-to-hto-date" in the dialog 

- enter "." (without ") for the "date" parameter

- click "Confirm"

- save changes by clicking the save-button in the main 

toolbar

The provided date format in the instance data 

corresponds to the xsd-date format

Evaluation of the input format

- Expand "Input" and open "biellaEvents.xml" 

- check the date format for <dateMin>, it should be 2011-

10-15T12:00:00

Expected result

- as soon as the mapping link is created  a black line appears connecting 

both elements

- when selecting a link a dialog window appears

- setting the mapping specifications the link's color is changed to green

o

TM w

IM

The result is as expected, but it is not easy 

to guess, which is the right choice... maybe 

the wording could be different (see 

comments line 42)

dateMin in source biella is start date in 

hto, the format has to be chosen "hto:xsd-

date-to-hto-date", why then for the 

dateMax (which is the end date in hto) 

does not work the same "hto:xsd-date-to-

hto-date", and has to be chosen 

"yyyymmdd-date-to-hto-date"? In the xml 

of the biella event both have the same 

fortmat (namely: 20112011T12:00:00 / 

yyyymmddThh:mm:ss)

MT2.12 MT2

Perform 

transformaiton 

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the output has another new element: <startDate>

- the start date has three sub-elements: <year>, <month>, <day>

- check the value for each sub-element, e.g., 2011 (year), 10 (month), 15 

(day)

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

MT2.13 MT2 Date mapping Date mapping 

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Map a date formated in ddmmyyyy

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "dateMax" in the "biella" schema

- click on "endDate" in the "hto" schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- select the newly created link

- select "hto:ddmmyyyy-to-hto-date" in the dialog 

- enter "." (without "") for the "date" parameter

- click "Confirm"

- save changes by clicking the save-button in the main 

toolbar

The provided date format in the instance data 

corresponds to a format like: 20112011T12:00:00

Evaluate the date format of the instance data

- Expand "Input" and open "biellaEvents.xml"

- check the date format for <dateMax>, it should be 

something like 20112011T12:00:00

Expected result

- as soon as the mapping link is created a black line appears connecting 

both elements

- when selecting a link a dialog window appears

- setting the mapping specifications the link's color is changed to green

o
TM o

IM

See comments in line 42.

MT2.14 MT2

Perform 

transformaiton 

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the output has another new element: <startDate>

- the start date has three sub-elements: year, month, day

- check the value for each sub-element, e.g., 2011 (year), 10 (month), 15 

(day)

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

as expected

Transformation Transforms a mapping to XSLT.
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MT2.16 MT2 Set hto language Set hto language

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Map hto:languageText elements (e.g., long description)

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "longDesc" in the "biella" schema

- click on "longDescription" in the "hto" schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- select the newly created link

- select "hto:languageText" in the dialog 

- enter "." (without "") for the "text" parameter

- enter 'de' (including the ') for the "language" parameter

- click "Confirm"

- save changes by clicking the save-button in the main 

toolbar

Note: Once a language text has been mapped, the 

language parameter is saved automatically and 

available via the drop-down list. 

Expected result

- as soon as the mapping link is created a black line appears connecting 

both elements

- when selecting a link a dialog window appears

- setting the mapping specifications the link's color is changed to green

o

TM o

IM

typed 'it' instead

MT2.17 MT2

Perform 

transformaiton 

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the output has another new element: <longDescription>

- <longDescription> has two sub-elements: <text> and <language>

- make sure the language-value is set to "de"

- check if the text-value is set (may vary depending on the instance data)

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

as expected

Delete a 

mapping link

Delete a mapping 

link

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Delete a mapping link as follows

- select "Select" from the components list 

- left-click the link between "articleName" and 

"shortDescription"

- select "delete"

- left-click the link between "contactWeb" and 

"shortDescription"

- select "delete"

- save your changes

Expected result

- the links between "articleName", "contactWeb" and "shortDescription" 

are deleted and not present anymore

o

TM o

IM

mac user… everywhere you write left-clicks 

should be right-clicks!!

MT2.17 MT2

Perform 

transformaiton 

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the generated output has no <shortDescription> element anymore

o

TM o

IM

as expected

MT2.18 MT2

Reuse already 

set language

Reuse already set 

language

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd)

Reuse language settings

- select the "link" component from the component list next 

to the modeling canvas (left hand side)

- click on "longDesc" in the "biella" schema

- click on "shortDescription" in the "hto" schema

- select the "Select" component from the component list 

next to the modeling canvas (left hand side)

- select the newly created link

- select "hto:languageText" in the dialog 

- enter "." (without "") for the "text" parameter

- click the drop-down boxk and select 'de' for the 

"language" parameter

- click "Confirm"

- save changes by clicking the save-button in the main 

toolbar

Note: The Biella schema does not have a short 

description. However, for demonstration purposes we 

will map the long description to the 

Expected result

- mapping dialog: the previously set language ('de') is available via the 

drop-down box for the langauge parameter

- confirming the mapping specifications changes the link's color to green

o

TM o

IM

as expected
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MT2.19 MT2

Perform 

transformaiton 

Perform 

transformation

Prerequisite: Imported demo project and imported schema 

files (biella.xsd, hto.xsd); existing mapping

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the <shortDescription> element appears again with two sub-elements: 

<text> and <language>

- make sure the language-value is set to 'de'

- check if the text-value is set (may vary depending on the instance data)

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

as expected

MT2.20 MT2

Provide 

feedback about 

the graphical 

feedback (green, 

black links)

Provide feedback 

about the 

graphical feedback 

(green, black links)

Provide feedback about the graphical feedback (green, 

black links)

IM

a) The link 'sticky' function… still think 

there should have an integrated solution to 

'guide' the user to the select functionality 

(maybe the first link could activate a 

dialoge informing to change into the select 

function to confirm or edit the link).

b) the value mapping condition dialogue 

disapears if you click on another 

application on your computer even if you 

have not set a parameter for value; it could 

remain there and disapear once the link is 

confirmed, it is clicked in the white area of 

the viewer or esc is hit. Or it could have a 

'close window' button.

Provide 

feedback about 

the interlinking 

method

Provide feedback 

about the 

interlinking 

method Provide feedback about the interlinking

Wording is still very technical ("hto:value-of", 

"createTX", "hto:xsd-date-to-hto-date"), is not clear. 

 use "target" instead of hto, 

 use "source" instead of xsd,

 use "test mapping, or view result of mapping" instead 

of create TX, 

 get the data from the example xml ("mostra" ), instead 

of showing a "." after value

Simple vs. complex mapping

If most of  value mappings are simple: only 'confiming' the link (e.g. title 

string), why not directly hide the conditioning (havint to enter a "."). Show 

complex conditioning only for those values that need it (e.g. date). I 

propose to have the conditions spread when the editor requests it (PIC 

simple_mapping_confirm.png)

IM

Interlinking dates: so ok, it is obvious that 

you are linking from xsd (source) to hto 

(target), so why repeat it? Why not offer 

the user to define their format? E.g.

 YYYYMMDD

 DD-MM-YYYY

 DD.MM.YYYY

 DDMMYYYY

or even better, with a sample-date:

1.1.2000

2000-01-01

...[more can be found in excel]

interlinking text: If I where not to have the 

cheat sheets, how would I know that the 

language has to be defined by de, it, en... 

and cannot write deutsch, italiano,... this 

would be easier if in the window, an 

example could be provided, also i find 

weird that I have to set semi-colon 'en'...It 

is just not intuitive enough.

sim
p

le_
m

ap
p

in
g_co

n
firm

.p
n

g

Provide 

feedback about 

the Graph View 

editor

Provide feedback 

about the Graph 

View editor Provide feedback about the Graph View editor

IM

a) An information about the links appears 

when mousover a link (from/to). This 

information should not hang around too 

much (PIC mouseover_limit.png)

Another day this did not happen (maybe 

the computer was running slower, and this 

is not the mapping tool, but the 

computer.)

m
o

u
seo

ver_lim
it.p

n
g

Provide general 

feedback 

Provide general 

feedback Provide general feedback

IM

At the moment nothing more… see general 

functionality improvement (languagues 

and dates). The trouble is, this is not an 

example that I can then test results, that is 

still what I am looking for in the test cases, 

to output a file and actually use it

pics_R4/simple_mapping_confirm.png
pics_R4/mouseover_limit.png
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Following a strict 

mapping process

A user follows a defined mapping process that suggests the 

elements that a domain expert has to map

Prerequisite: Imported demo project and imported 

schema files (biella.xsd, hto.xsd); existing mapping

MT2.21 MT2

Delete all 

mapping links

Delete all mapping 

links

Delete the previously created mapping links

- select each link by a right-click and select "delete"

- save your changes

- close the mapping file "biella.harmonize"

- double-click "biella.harmonize" again in order to re-open 

the mapping editor

Note: To refresh the settings it is required to 

close and re-open the mapping file

Expected result

- all links are deleted and do not appear anymore on the modeling canvas

o

TM o

IM

as expected

MT2.22 MT2

Change the 

mapping editor

Change the 

mapping editor

Switch to the Form View mapping editor

- click the "Form View" tab at the bottom of the mapping 

editor

Expected result

- a form view editor appears in the editor pane

- the "Form View" tab is active (highlighted) 

- the "biella" schema is listed as a tree view on the left hand side of the 

editor

- the right hand side of the editor shows the mapping steps: (i) a table and 

(ii) 4 bullets (Step 1, Step2, Step3, Step all)

- "Step all" is checked

o

TM o

IM

as expected

MT2.23 MT2

Mapping the 

basic description 

Mapping the basic 

description

Mapping the title element

- select "Step 1" 

- select "title" from the table on the right hand side

- expand the biella schema shown on the left hand side

- drag&drop the "title" element onto the second table (right 

below the first one)

- select "hto:languageText"

- type 'en' (including ') as parameter into the drop-box for 

the "language" parameter

- press "Confirm"

- save your changes

Explanation: The form editor is separated 

into two parts: the left hand side shows the 

source schema (biella), whereas the right 

hand side shows the target schema (hto). 

The mappers task is to provide an adequate 

mapping for required target elements. These 

elements are defined by a fixed mapping 

process. The mapping process in the context 

of the HarmoSearch mapping tool is called 

"Filter". The corresponding filter file 

(filter.xml) is located in the "Filter" folder. 

Note: We leave the subtitle element 

unmapped since no corresponding opposite 

element exists in the biella schema!

Expected result

- the "title" tag changes ist color from white to green (showing that the 

mapping has been completed)

- "subtitle" remains in white (not mapped) status

o

TM o

IM

ohhh!

MT2.24 MT2

Perform 

transformaiton 

Perform 

transformation

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the Feedback View appears on the right hand side of the modeling 

canvas

- the Feedback View shows 4 events in the HTO format, which is the 

output of the transformation (XSLT)

- each event (starting with <event>) has a <mainTitle> tag

- the elements "mainTitle" should have a value: Mostra for the first three 

events, Mostre for the last event

- make sure no <subTitle> element exists

NOTE: The values differ due to the provided instance data!

o

TM o

IM

as expected
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MT2.25 MT2

Mapping the 

additional 

information 

Mapping the 

additional 

information 

Switch to step 2

- select "Step2"

Mapping the long description element

- select "longDescription"

- drag and drop "longDesc" from the biella schema to the 

table below

- select "hto:languageText"

- select the already defined language 'en' from the drop-

down list

- press "Confirm"

- save your changes

Mapping the Begin Date

- select "beginDate"

- drag and drop "dateMin" from the biella schema to the 

table below

- select "hto:xsd-date-to-hto-date"

- press "Confirm"

- save your changes

Mapping the End Date

- select "endDate"

- drag and drop "dateMax" from the biella schema to the 

table below

- select "hto:ddmmyyyy-data-to-hto-date"

- press "Confirm"

Note: Short description and day times will 

not me mapped since we are not able to find 

a corresponding opposite in the biella 

schema

Expected result

- Step 2 is active and the corresponding elements are shown in the table

- their default status is not-mapped so far (white box)

- after confirming the mappings for "longDescription", "startDate" and 

"endDate" their status changes to done, wich is illustrated by a green box

o

TM o

IM

as expected, ant might I say done in less 

than 1 minute!

PS Still thinking we should rephrase the 

options "hto:xsd-date-to-hto-date" 

and"hto:ddmmyyy-data to-hto-date"

MT2.26 MT2

Perform 

transformaiton 

Perform 

transformation

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the output shows 2 new elements: <description>, <timeline>

- <timeline> is composed, among others, of <startDate> and <endDate> 

elements

- check that <startDate> as well as <endDate> have assigned values for 

<year>, <month> and <day>

- <description> contains among others <longDescription>

- make sure the sub-elements <text> and <language> contain a value (en 

in case of <language>)

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

as expected

MT2.27 MT2 Mapping step 3 Mapping step 3

Switch to step 3

- select "Step 3"

Mapping the category

- select "category"

- drag and drop "kwID" from the biella schema (sub-

element of "eventType")

- select "hto:Category"

select "." from the drop-down list

- press Confirm

- save your changes

Note: the remaining elements "organiser 

id" and "location id" will be mapped in 

the next step for demonstration 

purposes of the graphical domain-expert 

feedback

Expected result

- Step 3 is active and the corresponding elements are shown in the table

- their default status is not-mapped (white box)

- after applying the mapping "category" switches to done (green box)

- organiser id and location id remain white (not mapped at all)

o

TM o

IM

as expected

MT2.28 MT2

Perform 

transformaiton 

Perform 

transformation

Perform transformation 

- click "createTX" in the main toolbar 

- check the result in the Feedback View

Expected result

- the output shows a new element: <category>

- check if  the sub-element <domainValue> is set (e.g., exhibition 

european art before 1800)

NOTE: The values depend on the provided instance data! Thus, they can 

vary!

o

TM o

IM

as expected

MT2.29 MT2

Set a mapping 

to status 

unknown

Set a mapping to 

status unknown

Indicate organiser id as unsolved mapping

- select "organiser id" 

- drag and drop "pid" onto the table below

- save your changes

In case the domain-expert does not feel 

confortable with a solution or is not able to 

do a mapping at all but is sure that a 

corresponding opposite exists in the source 

schema he is able to provide graphical 

feedback.

Expected result

- the "organiser id" changes ist color to black

- this indicates that the domain expert is not sure about the correctness of 

the proposed mapping

- the feedback indicates "additional support needed"

o

TM o

IM

alternativelly, the user (as I did), can open 

in the viewer in the folder "input" , the 

"BiellaEvents.xml" where he/she can see 

the actual values being mapped. 
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MT2.30 MT2

Set the mapping 

status to TODO

Set a mapping 

status to TODO

Mark location id as "TODO"

- select "location id"

- drag and drop "id" onto the table below

- click on "id" 

- select "TODO" from the drop-box

- press "Confirm"

- save your changes

Setting a mapping status to TODO signals the technical 

expert that the domain expert was not able to solve 

the mapping. Potential reasons may be missing pattern 

support. As a consequence the technical expert has an 

anchor and knows where to hook in in order to solve 

the problem and finalize the mapping, e.g., by 

implementing the missing pattern

Expected result

- the "location id" changes ist color to red

- such a mapping indicates that the corresponding opposite has been 

found but cannot be mapped to hto due to technical reasons

- such mappings require additional technical support, e.g., implementing 

the missing pattern

o

TM o

IM

as expected

comment 1: what if the domain expert, has 

no clue as what to choose? Could not be 

possible to mark location id in the hto 

element as TODO?

Comment 2: where to set to TODO, in the 

hto:Referencedvalue or hto:value-of?

MT2.31 MT2

Reset an already 

defined 

mapping

Reset an already 

defined mapping

Reset the mapping for location id

- select "location id"

- select "id"

- select "reset" from the drop-down box

- press "Confirm"

- save your changes

In case the domain expert thinks an already set 

mapping has to be reset

Expected result

- the "location id" changes ist color to white (no mapping at all)

o

TM w

IM
it is black (pic reset_mapping.png)

What is the difference between reset and 

delete?

reset_m
ap

p
in

g,p
n

g

MT2.32 MT2

Functionality 

feedback

Functionality 

feedback

Provide feedback about the functionality of the Form View 

mapping editor

IM

I am fan!

It can be handled better than the Graphical 

view, where switching from Link function 

to Select function and the many windows, 

added complexity to the process. 

The form view is more intuitive, once you 

know you have to activate the element in 

the hto filter to be mapped, and know the 

area where the source schema element 

has to be dropped... is easy peasy!!

still, the content of the mapping 

conditioning could be simplified

MT2.33 MT2

Feedback about 

the graphical 

domain expert 

feedback 

functionality

Feedback about 

the graphical 

domain expert 

feedback 

functionality

Provide additional feedback about the graphical domain 

expert feedback functionality

IM

?? You mean set a link as TODO? This is 

great if I knew of a case of a user having a 

technical expert behind to finish up their 

work, maybe Sabine, can give you some 

feedback about this...

MT2.34 MT2 UI Feedback UI Feedback Provide feedback about the Form View UI

IM

I made a pic with comments Form_ui.png

Fo
rm

_u
i.p

n
g

MT4

Transformation 

Process Potential functionality regarding transformation

Use HTML as 

output format

Use HTML as 

output format

Prerequisits: An existing project and corresponding 

mappings

Requirements: Note, in order to generate HTML output a 

proper transformation template (XSLT) is required that is 

suitable to transform the resulting XML output to HTML

Change the process settings

- Expand the "Input" folder

- double-click "process.xml"

- uncomment "<Xsl>Pattern/hto2html.xsl</Xsl>" by 

removing "<!--" and "-->"

- change the value of "<Output>" to "html" (without ")

- save your changes

Perform transformation

- click "createTX" in the main toolbar

- check the result in the Feedback View

Expected result

- the standard XML output has changed to HTML listing the corresponding 

events and mappings in table form

o

TM o

IM

did this, once I had mapped all fields from 

the excercise above (including: title, dates, 

description, categories), and the categories 

were not outputed in the html output 

(while they where output in the xml 

feedback

MT3 User assistance User assistance

Refers to relevant enhancments helping the user handling 

the mapping tool

pics_R4/reset_mapping.png
pics_R4/Form_ui.png
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MT3.1 MT3 Integrated help Integrated help

Open the integrated help

- Click "Help > Help Contents" in the main menu

- Expand the "HarmoSearch Mapping Tool User Guide" 

node

- Expand "Getting Started" 

- Expand "Basic Tutorial"

- Click "Create your first mapping project"

Note: The documentation is in a pre-leminary state 

due to the prototypical status of the mapping tool. 

Expected result

- The integrated help dialog pops up

- The help contents appear on the left hand side and contain two nodes (i) 

"HarmoSearch Mapping Tool User Guide" and (ii) "XSL Tools User 

Documentation"

- "HarmoSearch Mapping Tool User Guide" contains 4 sub-nodes

- "Getting Started" and "Concepts" are further refined by additional sub-

nodes

o

TM

Documentation appeared as 

expected

w

is there a way around the firewall (i cannot 

change my firewall settings, and these do 

not allow the mapping tool to connect).

Alternatively you could ask Adriano or 

David (or Peter) to do these test lines?

MT3.2 MT3

Cheatsheet 

support

Cheatsheet 

support

Prerequisite: To accomplish this task the installation of 

the third party plugin 

"harmosearch.mappingtool.cheatsheets" (see task MT0.6)

Open the cheatsheets

- Click "Help > Cheatsheets…"

- Expand "HarmoSearch"

- Select "Create a new "Hello World" mapping project"

- Click "OK" 

- Start the cheat sheet by clicking "Click on Begin" in the 

Introduction section

- Follow the instructions

Expected result

- The "Cheat Sheets" View opens and shows the content of the "Create a 

new "Hello World" mapping project

- The cheatsheet is separated into 5 sections 

- Interacting with the cheatsheets result in for example calling a wizard or 

moving to the next explanatory section

o

TM w

is there a way around the firewall (i cannot 

change my firewall settings, and these do 

not allow the mapping tool to connect).

Alternatively you could ask Adriano or 

David (or Peter) to do these test lines?

MT3.3 MT3

Feedback about 

the help 

contents

Feedback about 

the help contents

Potential question

- What are must have criteria for the user documentation 

provided by the mapping tool

o

TM

MT3.4 MT3

Feedback about 

the cheat sheets

Feedback about 

the cheat sheets

Potential question

- What functionality should be covered by means of a cheat 

sheet
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RL1 User creates and uses a mapping of referenced lists

RL1.1 RL1

RL1.1 - 

RL1.11

Download 

Mapping 

Tool

Download the Mapping Tool (v4.0.3) from the portal in 

'Configurations' -> 'Mapping Store'. To do this you can log 

in with user 'tester@mapping.tool', password 'testuser'. 

 Choose the 32 or 64 bit version depending on your 

Windows OS.

Alternative (to shorten the download time):

Download the Mapping Tool from SVN at 

"07/Demonstration_Activities/MappingTool_<nn>bit"

It is important that your installation 

directory does not contain any spaces, 

otherwise the tool will not start

O

P
ro

m
o

ter

O

A
fid

iu
m

o

SP
K O

A
fid

iu
m

o

ectrl

RL1.2 RL1

RL1.1 - 

RL1.11

Launch the 

Mapping 

Tool Double click on the 'Flocke.exe' file

For ease of use, the tool on SVN has already 

a preloaded project containing the data 

mapping. The test consists in creating the 

mapping of reference lists.

O

P
ro

m
o

ter

O

A
fid

iu
m

o

SP
K O

A
fid

iu
m

o

ectrl

RL-ext1

Open the 

editor for 

creating a 

mapping of 

data 

(between the 

concepts of 

two data 

schemas)

Within the Mapping Navigator View, open 'Mapping-

>museoliitto_mapping.harmonize' (double click or right-

click: 'Open With->Harmonize Model Editor')

For ease of use, the preloaded project 

contains already a source and a destination 

schema, and a preexisting mapping.The test 

consists in extending the mapping with one 

new link.

O

P
ro

m
o

ter (7/2/2013)

o

SP
K

 (19/2/2013)

o

A
fid

iu
m

o

ectrl

RL-ext2

Add a 

mapping for 

the concept 

Category

1. Select Step 3

2. Select 'category' in the Target Schema list. 

3. Find the 'categories' element in the Museoliitto source 

schema

4. Drag it onto the 'Link to Source' list in the Mapping(s) 

section, and select it (it is grey colored)

5. Select 'hto:SKOSCategory' listed in the Mapping Details 

section

6. Type 'http://www.tu.at/' (including the ') into the text 

field of the UniqueID parameter

7. Choose 'category_id' from the drop-down box of the 

value parameter

    a. Note, the 'category_id' is a sub element of categories 

and contains the actual value that has to be mapped. 

Thus, it must be specified as an input parameter for the 

hto:SKOSCategory mapping pattern.

8. Confirm your mapping by clicking the Confirm button. 

('categories' becomes green colored)

- save the project

This operation creates a new mapping link  

that maps a concept from the Museoliitto 

source reference list to a concept of the 

Harmonise target reference list. Thus, it is 

necessary to create also the mappings 

between the single values of the two (source 

and target) reference lists.
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RL-ext3

Recreate the 

output 

mapping file

1. Double-click the museoliitto_mapping.harmonize 

mapping file

2. Re-create the transformation output by clicking the 

'Create and run Transformation' yellow arrow button in 

the toolbar

3. Close the Feedback View

The Feedback View shows 

you the output of running 

the mapping on a test input 

file (preloaded in  the Input 

folder)
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x

SP
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 (19/2/2013)

In the feedback view (where I can see the 

reuslt of the transformation -

unfortunately only in xml, not in html-), 

the category is not matched: 

"<category>No matching concept found 

for: http://www.tu.at/Tanz</category>" 

(see screenshot)
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Id

Pare

nt

Sequen

ce Name Description

Comment

 (and alternatives) Expected Output 28
/1

/2
01

3

W
h

o

29
/1

/2
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3

W
h

o

5/
2/

20
13

W
h

o

Actual Result 18
/2

/2
01

3

W
h

o

Actual Result 21
/2

/2
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3

W
h

o

RL1.3 RL1

RL1.1 - 

RL1.11

Open the 

editor for 

creating a 

mapping of 

values 

(between 

two skosified 

reference 

lists)

Within the Mapping Navigator View, open 'Mapping-

>valuemapping.values' (double click or right-click: 'Open 

With->Value Mapping')

For ease of use, the preloaded project 

contains already a source and a target 

reference list (represented as skos relations) 

and a sample mapping between the two 

(also expressed with skos terminology). 

Note that the source and target reference 

lists in this demo are loaded from the 

workspace on your file system (you can 

check with  right-click: 'Open With->Text 

Editor') . But they could also be loaded from 

a public URL, clicking on the button above 

each value tree.
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RL1.4 RL1

RL1.1 - 

RL1.11

View the 

existing 

mapping

In the central tab below the value tree (Concept A - maps 

To - Concept B) right-click and select 'Show All Relations'

The concept 

<http://www.tu.at/Bildhaue

rei> is mapped to the 

concept               

<http://www.harmonet.org

/sculpture> .
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RL1.5 RL1

RL1.1 - 

RL1.11

Modify the 

existing 

mapping

In the values tab, select 'Tanz' on the left and 'dance' on 

the right

- right-click and select 'Create Relation'

- do the same for 'Malerei' and 'painting'

- save the project

If you do again 'Show All 

Relations' on the below tab, 

you will see all three 

concept mappings
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RL1.6 RL1

RL1.1 - 

RL1.11

Make the 

values 

mapping 

available 

from a public 

queryable 

triple store

This step is done by the administrator, who uploads the 

file in the Fuseki server (which is the container of the 

semantic registry) of HarmoSearch.

You may ask Claudio Prandoni or Marlis Valentini to 

substitute the actual file on the server with yours, or just 

check that your file looks like 'valuemapping-

output.values' in the test folder, and proceed with the 

test.

The mapping of values is represented as skos 

relations between two skosified reference 

lists. The triple store is needed in order to 

interpret such type of mapping specification.

Check that your file looks 

like 'valuemapping-

output.values' in the test 

folder
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RL1.7 RL1

RL1.1 - 

RL1.11

Upload the 

support 

libraries

This step is already done: the libraries needed by the 

schema mapping (in 'Museoliitto/Pattern') are already 

uploaded as private libraries on the portal

Optional:

Logged in as 

tester@mapping.tool 

(passw: 'testuser') on the 

portal, you may check in 

'Configurations'->'Mapping 

Store' that there are 4 

private libraries for the 

'testmappingtool' 

organization
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RL1.8 RL1

RL1.1 - 

RL1.11

Update the 

mapping file 

to reference 

correctly the 

support 

libraries

Open the file 'Output/museoliitto_mapping2hto.xsl', and, 

if necessary (*), update the 2 <xsl:include> instructions 

with: 

<xsl:include href="../privateSupportLibs/htov2-1-

extension.xsl"/>

<xsl:include href="../privateSupportLibs/htov2-1.xsl"/>

* When a test transformation is run, the 

include paths are updated automatically to 

link to the libraries in your workspace
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museoliitto_mapping2hto.xsl" already had 

both lines
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Id

Pare

nt

Sequen

ce Name Description

Comment

 (and alternatives) Expected Output 28
/1

/2
01

3

W
h

o

29
/1

/2
01

3

W
h

o

5/
2/
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o

Actual Result 18
/2

/2
01

3
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o

Actual Result 21
/2
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3
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RL1.9 RL1

RL1.1 - 

RL1.11

Upload the 

schema 

mapping file 

on the portal 

(from your 

local system 

to HTO)

log in with user 'tester@mapping.tool', password 

'testuser'

- go in 'Configurations' -> 'Mapping Store'

- insert 'events' as collection id

- choose 'Upload mapping from local system to 

Harmonise ontology (for sending data)'

- select the mapping from local system to Harmonise 

ontology (choose the file 

'Output/museoliitto_mapping2hto.xsl')

select 'default for sending events'

click on 'Send' and check for the success message on top 

of the page

The upload of mappings is also be available 

as Web Service invocation to the portal. 

However the current version of the Mapping 

Tool lacks still the GUI that allows this 

operation.

The uploaded mapping references on one 

hand the support libraries and the other 

hand the separated mapping of values, 

which is implemented as skos relations 

between two skosified reference lists. This 

implies that Fuseki is involved in interpreting 

the part of mapping between data values.

The mapping is listed in the 

box at the end of the page.
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RL1.10

RL1.1 - 

RL1.11

Execute a 

push

logged in as 'tester@mapping.tool', go in 'Exchange Data' 

-> 'Share Data' and select 'Push Data'

select 'Test' as receiver and the 

file'Museoliitto/Input/museoliitto.xml' (available in the 

workspace of the MappingTool) as data file 

click on 'Send'

Screen message and 

Operation Status report the 

success of the operation. 

Log in as 

'testuesr@test.user', 

password 'testuser' 

- go in 'Data Repository' -> 

'Inbox'

- download the just received 

file and check that the 

occurrence of Tanz has been 

mapped into 

'http://www.harmonet.org/

dance'.
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RL1.11

RL1.1 - 

RL1.11

Remove 

schema 

mapping

log in with user 'tester@mapping.tool', password 

'testuser'

- go in 'Configurations' -> 'Mapping Store'

- delete the mapping from local system to HTO

The mapping is no more 

listed in the box at the end 

of the page.
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APPENDIX C. ACCEPTANCE NOTES 

This section gathers all acceptance notes validated by the partners for each release. 

Appendix C.1. Acceptance notes for RC1 of the Mapping Tool 

The following section is an excerpt, addressing only the Mapping Tool, of the 

document Acceptance Notes for Release 2, which is available in its complete 

version in D7.1 „Compiled collection of acceptance notes‟. 

Note: Release candidate 1 of the Mapping Tool was included in release 2 of the 

overall HarmoSearch system. 

 

Software 

Release 2 does not correspond to a specific deliverable but to the second release of 

the integrated Metasearch Core engine and of the first release of the mapping tool. 

Content of release 2 encompasses: 

 [...] 

 First release of the mapping tool  

 

SME Acceptance 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH Conditional 

2 ECTRL SOLUTIONS SRL Conditional 

3 EC3 Networks GmbH Conditional 

4 Lehmann & Werder Museumsmedien Conditional 

5 AFIDIUM Conditional 

 

Other partner comments 

NO COMMENT 

  

Consortium acceptance 

The consortium thereby accepts the Metasearch Core Engine part of the release 

and considers that it covers requirements.  

However, the mapping tool has been accepted with conditions. 
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Conditions and Non Acceptance Notes 

The mapping tool in its present state is not usable for non technical experts. This is 

not compliant with the initial expectations. To remedy this situation a number of 

actions have been agreed with the RTD partner (see next section). 

  

Appendix C.1.a. Acceptance Conditions for RC1: Action Plan 

This section is the content of the document „workplan15-11-2011.doc‟. It contains 

the conditions for acceptance of the Release Candidate 1 of the Mapping Tool. 

Work Plan November 2011 to end of Project 

Albert Rainer 

Thomas Motal  

The following components, extensions, and focal points have been identified and 

presented at Paris Meeting November 2011 

Recommender:  

EPM (Expected Person Month): 2 

Proposes matches between source and target schemata (“automatic Mapping”). 

A basic implementation has been integrated: Editing distance (Levenshtein). The tool 

should allow specifying the algorithms together with optional parameters that should 

be used in the schema matching process. 

Tasks: 

Configuration: An addition to the current project configuration method in order to 

specify matching algorithms and parameters. 

Algorithms: Implementation of a suitable SW-Pattern that can be extended in order 

to provide concrete algorithm instances. 

Status: Basic version available. Next: Halted at the moment, needs review of 

approach since schemas and data of current harmonize partners are too ill-defined 

to yield any useful results. 

Immediate feedback on transformations: 

EPM: 3 

Instance data is transformed on-the-fly during the mapping process. The tool shows 

the result of data mapping to the user. In addition, assertions on instance data may 

be used for automatic testing purposes. This also corresponds to Task 4.3 - 

Deployment of processor – and Deliverable 4.2 - Implementation of query processor 

as contribution to mapping application.  

Tasks: 

Source: Currently, input is limited to static XML files. The query processor developed 

in WP 4 is integrated as additional input source. 
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Transformer-chain: There exists a Transformer-Chain that has been developed for 

the Harmosearch Metasearch Demonstration in Berlin. This chain has to be 

integrated to the mapping tool.  

Feedback view: A suitable view (XML, HTML Browser) is to be integrated into the 

mapping tool that is capable to show feedback on-the-fly. 

Status: Basic version available. Next: automatic reload on model changes.   

XML, XSLT view: 

EPM: 1 

Both exist as Eclipse components and have to be integrated.  

Present mappings to technical experts.  

Major challenge here is to synchronize the views for domain experts and technical 

experts 

Tasks:  

Configurate Eclipse in order to integrate these views.  Implement a mechanism  to 

synchronize views on the model. 

Status: Basic version available. Next: Domain expert implementation request to 

technical expert (create a TODO task with basic template structure)       

Request support:  

EPM: 3  

Main focus of mapping tools (including Flocke) is support for data translations of 

query outputs or other kind of responses. But support for requests is very important 

in dialogue situation.  

Tasks: 

Extension of the current mapping tool in order to support request mappings.   

Status: Not started yet  

More Pattern support for Harmonise ontology:  

EPM: 3 

Possibly outsourced to Anna Bruseva as Practical (Professor Dorn). Anna did existing 

mappings Euromuse – Museums    

Patterns are pieces of (XSLT-) Software similar to methods/functions known from 

programming languages. 

Currently, only a few patterns are implemented that support the Harmonise 

ontology. Needs some research in order to come up with a solution as to which 

patterns make sense. 

Tasks: 

Documentation of best practices for code reuse in XSLT projects. This includes 

methods that describe how code documentation could be done, how code retrieval 

works, and how code maintenance such as version management could be applied.  
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Status: Basic version available. Next: Additional elements for the auto-

documentation as basis for propose-critique support.       

XSLT code generator:  

EPM: 5  

Current version is only a stub, needs rework in order to create strict XSLT 2.0 code.  

One of the most challenging problems, independently of the user interface 

employed. We see this component as the one that generates a heavy workload and 

as work in progress until the end of project. 

Tasks: 

Implementation of extended code generator  

Status: Basic version available. Next: Research on existing solutions.   

Update mechanism:  

EPM: 0.5  

Implementation and integration of the equinox update mechanism for Eclipse RCPs. 

The main purpose of this task is to: (1) Allow a minimal invasive approach for 

product migration; (2) allow users to add additional functionality provided by third 

party vendors.  

Status: Basic version available  

Mapping guidance for the domain expert:  

EPM: 6  

The purpose of this task is to provide an adequate mechanism to make the 

underlying mapping process feasible and understandable for the domain expert. 

Thereby, the focus is on supporting the user to map a concrete XML schema to the 

Harmonise ontology. The representations of the process as well as the user interface 

are thereby crucial. Both need to be understandable and adequate by means of 

identifying and mapping basic mapping scenarios. 

Status: Basic version available. Next: List of proposals for extensions.  

Configuration mechanism:  

EPM: 2  

The configuration mechanism is used to control and configure the behaviour of the 

mapping tool. This includes not only the environmental behaviour (e.g. code 

highlighting) but also mapping related issues. The latter is addressed by so called 

domain-specific profiles. 

Status: Basic version available  

Mapping project management:  

EPM: 1.5  
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Mapping solutions are organized by means of projects. These projects can be 

manipulated by the user in any direction (create, delete, rename, etc.). 

Furthermore, several resources (e.g. filter, pattern, schema files) are needed to 

apply a valid mapping procedure. Creating and managing mappings is complex and 

time intensive. Thus, it is necessary to (1) provide an adequate and easy to use 

interface allowing a domain expert to manipulate and interact with projects or 

resources and (2) make the interface as simple and neat as possible. The latter is 

especially important for an effective and fast mapping experience. 

Status: Basic version available  

Documentation and deliverables:  

EPM: 2  

The purpose of this task is to document components, implementations, and manuals 

associated with the developed mapping tool. Additionally, some parts of the 

documentation are integrated into the help system of the HarmoSearch mapping 

tool. 

Status: Ongoing 

Scientific work:  

EPM: 1.5  

This task relates to creation and publishing research results that have been gained 

during the project period. The overall purpose is to share and distribute the scientific 

contributions among the research community. 

Status: Not started yet  

Connection to Harmosearch mapping store:  

EPM: 1 

Mapping store a component of Harmosearch portal. 

Keeps schema mappings and is used by the Reconciliation component (another part 

of the Harmosearch portal) in order to perform data transformations.  

Mapping tool can connect to the portal and upload/download mapping artefacts. 

Tasks: 

Implement a connector to, respectively, upload or download XSLT artefacts to/from 

the mapping store. The Interface provided by the Mapping store is described in 

Deliverable 2.2 Section 5.2.12 

Status: Not started yet Next: Basic implementation available for Release 3 (Feb 

2012) 

NEW: Reference lists handling in mapping editor: 

EPM 3  

A reference list is a means to overcome the semantic heterogeneity problem of 

domain values (different naming, similar relations) 
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Precondition: Needs clarification and mutual agreement on how to represent 

reference lists  

Tasks: 

Literature review of existing solutions and presentation of proposal (scheduled 

February 2012)  

Implementation of a mechanism to handle heterogeneous domain values and to 

create the mappings  

Status: Not started yet. Next: Literature review 
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Appendix C.2. Acceptance notes for RC2 of the Mapping Tool 

The following section is an excerpt, addressing only to the Mapping Tool, of the 

document Acceptance Notes for Release 3, which is available in its complete 

version in D7.1 „Compiled collection of acceptance notes‟. 

Note: Release candidate 2 of the Mapping Tool was included in release 3 of the 

overall HarmoSearch system. 

Software 

Release 3 does not correspond to a specific deliverable but to the first release of the 

complete Harmosearch system with the mapping tool integrated. 

Content of release 3 encompasses for the events subdomain: 

 The integration of the mapping tool into the system: download install from 

portal/ Assisted mapping upload and mapping validation (validation of the 

html viewer inside the mapping tool that activates when running the 

transformation) 

 The enhance mapping tool to map the queries as well 

 [...] 

In addition to the actual release additional work has been performed to define how 

to 

 Have reference list mapping methodology with one base reference list for 

mapping 

 Manage parameters on mapping (language, currency...) 

 [...] 

The enhanced mapping tool is present in the release. 

 

SME acceptance 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH Conditional 

2 ECTRL SOLUTIONS SRL Conditional 

3 EC3 Networks GmbH Conditional 

4 Lehmann & Werder Museumsmedien Conditional 

5 AFIDIUM Conditional 

 

Other partner comments 
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NO COMMENT 

  

Consortium acceptance 

The consortium thereby accepts this release and considers that it covers 

requirements on the portal. The mapping tool is accepted as a prototype, provided 

it is transformed in the next release to take into account the usability 

requirements.  

  

Conditions and Non Acceptance Notes 

Mapping tool is accepted as a prototype, provided that the next versions take into 

account the usability expected by the SME partners (see next section). 

 

Appendix C.2.a. Acceptance Conditions for RC2: Usability Notes 

This section is the content of the document „MappingToolReview.doc‟. It contains the 

conditions for acceptance of the Release Candidate 2 of the Mapping Tool. 

 

Notes on Usability of the Automatic Mapping Tool 

In general, the automatic mapping tool does what it is expected to do, and most of 

the functionalities are quite intuitive. The possibility to test the mapping immediately 

seems to be very interesting, as errors can be detected and thus corrected already 

in this early stage. The entire tool is kept quite simple such that it is not difficult to 

be used (when having some initial help or guidelines). 

Nevertheless, the help functionality is not yet complete (e.g., the help for the 

different views is missing). Some situations encountered when testing the mapping 

tool are described in more detail in the following. 

 

Installer: 

It would be preferable if the installer would notify the user when installing the 

automatic mapping tool, if the (pre-)specified directory already exists. 

 

Uninstaller: 

The uninstaller deletes the entire directory, and not only the files that were created 

by the tool or during the installation or usage. In this case, if the directory already 

existed (or, e.g. if the user chose something like c:/Programs) also files that should 

not be touched during this process will be deleted. Thus, the user should at least be 

notified when launching the uninstaller that this will be the behaviour. In this case, 

the user could “backup” some files or folders before this process. 

 

Project import: 
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This step is very intuitive and simple, as far as an entire Flocke project is available. 

Otherwise, a new project has to be created and possibly existing files can be 

imported as filters/input/schema/… 

 

Project export: 

The wizard to support the user when exporting a project is very intuitive and simple, 

such that it is easily possible to export an entire project to an archive that can be 

shared. 

 

Schema files: 

If an XML is available, the process of creating a new XSD schema is very simple and 

intuitive.  

However, when not having such an XML, this might get quiet complicated/annoying: 

All the elements have to be “opened” (by the arrow on the left hand side) to see the 

“name” attribute, which is necessary to understand the difference between the single 

elements. If a new element is added, also this new element is not opened, which 

makes it a bit complicated to understand what happens: When having a XSD file 

containing already a certain number of elements, and adding a new child element, 

this one is added at the end of the list, and it is not opened or marked. Thus, it is 

difficult to see which one of the elements is new (as all of them are closed by 

default). So in a first moment one has to look for this new element. In order to 

specify the name, one has to open the element, click on the name attribute and type 

it (the default is “NCName”). After that, the default type (“unique”) has to be deleted 

in most cases, and a new type has to be added. It would possibly be easier if the 

new added element is (by default) opened, and the text field of the name attribute is 

marked, to be edited immediately. 
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Graphical editor: 

The graphical editor is nice and intuitive to be used. It supports the user to create 

the mapping itself in a simple fashion, without forcing him to write plain XSLT (or 

similar files). The schema files can simply be dragged and dropped in the graphical 

view, and they can be moved (using the “select” command). It seems not difficult to 

understand how to create a new mapping by choosing “link”, and dragging a line 

from one field to another.  

In the window, which is opened when clicking on a mapping link line, I found a 

confusing reaction: In this window the user has to choose a type of mapping (It 

could be helpful if, in the case where only one type is possible, this one would be 

selected automatically). As soon as the user chooses one of the possibilities 
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(screenshot), the “confirm” button is activated. But when clicking on this button, no 

reaction is shown: The user has to double-click in order to confirm the selection. It 

was confusing for me, as I intended that perhaps the choice was made in the 

background (without any visual notification), but I assumed to have confirmed the 

chosen setting already with a simple click. This could perhaps be changed (or 

explained). 

   

 

Schema files –> graphical editor: 

One aspect that could be considered a bit annoying is related with the schema files 

and the graphical mapping editor: When having edited an XSD file, someone could 

consider that these changes are also reflected in the mapping (which is visible in the 

graphical editor). Perhaps I did not get the correct way how to do this, but in my 

case, the schema visible in the graphical mapping did not update. So, after having 

added a few fields to the XSD, I had to add the schema again to the graphical editor, 

remove the “old” schema, and redo the entire mapping. Perhaps there could be 

some help or automation when doing so. (Nevertheless, it is clear that this is a 

complicated process, as possibly “mapped” elements could have been deleted.) 

 

Error feedback: 

The feedback the user gets when an error occurred is currently a bit technical, as the 

stacktrace of the Java error message is shown. It would probably be more 

informative for non-technical users to get an error message they understand, e.g., 

the file has a wrong format or it is damaged (or something similar) and cannot be 

read. (But I assume this will still be changed for a future release). 

In the case of the screenshot for example a new file in the folder “Mapping” of the 

project was created with the filename “test.harmonize”. When then opening this file 

(the default editor is the graphical one for harmonize mapping files), an index-out-

of-bounds exception is shown: 



 

File: D6.3_Evaluation_Report_on_Validation_of_Results_of_Mapping_Tool Page 28 of 31 

FP7-SME-1   262289      

HARMOSEARCH                

Deliverable D6.3 

 

 

Help: 

The help menu is still in work, and thus not yet complete.  

It contains detailed information about how to import an existing project, but the 

guidelines describing the different views are still empty. 

 

It could perhaps be useful to have some help, explaining which files to put in which 

folder, when creating a new project (i.e., if the folders are all empty, not as shown in 

the screenshot). Once one sees where the files are located in an existing project 

(screenshot), it seems intuitive, but initially, not having this information, it is more 

difficult to understand that.  
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Appendix C.3. Acceptance notes for RC3 of the Mapping Tool 

The following section is an excerpt, addressing only to the Mapping Tool, of the 

document Acceptance Notes for Release 4, which is available in its complete 

version in D7.1 „Compiled collection of acceptance notes‟. 

Note: Release candidate 3 of the Mapping Tool was included in release 4 of the 

overall HarmoSearch system. 

Software 

Release 4 does not correspond to a specific deliverable but to the second release of 

the integrated Metasearch Core engine and integrated mapping tool. 

Content of release 4 encompasses the events and accomodation subdomain: 

 [...] 

 The enhanced mapping tool  

 

SME acceptance 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH YES 

2 ECTRL SOLUTIONS SRL YES 

3 EC3 Networks GmbH YES 

4 Lehmann & Werder Museumsmedien YES 

5 AFIDIUM YES 

Other partner comments 

NO COMMENT 

 

Consortium acceptance 

The consortium thereby accepts this release and considers that it covers 

requirements. The consortium acknowledges the numerous improvements in the 

mapping tool such as the form view that allows more intuitive data mapping. 

However a complete mapping could still not be performed with this release 

because of a number of missing functionalities. 
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Appendix C.4. Acceptance notes for RC4 of the Mapping Tool 

The following section is an excerpt, addressing only to the Mapping Tool, of the 

document Acceptance Notes for Release 5, which is available in its complete 

version in D7.1 „Compiled collection of acceptance notes‟. 

Note: Release candidate 4 of the Mapping Tool was included in release 5 of the 

overall HarmoSearch system. 

 

Software 

Release 5 does not correspond to a specific deliverable but to the third release of the 

integrated Metasearch Core engine and integrated mapping tool. 

Content of release 5 encompasses for the events subdomain: 

 The release 5 contains a complete Harmosearch platform including all the 

features (past and described below) as well as the latest graphical layout. 

o [...] 

The enhanced mapping tool is also present in the release: 

 Integration of reference lists and their mapping (categories, countries... but 

location names such as museums) 

 Integration of the management of an organization‟s mapping of reference list 

in the mapping tool, and use in the reconciliation engine (for expert users) 

 Integration of output mapping in the metasearch 

 Overall improvements of the mapping tool (dialog driven, step driven, user 

support while mapping, easy management of parameters without complex 

path, differentiation of elements with attributes to map to different items, 

multilingualism support, and pre-configured mapping). 

 

SME acceptance 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH Conditional 

2 ECTRL SOLUTIONS SRL Conditional 

3 EC3 Networks GmbH Conditional 

4 Lehmann & Werder Museumsmedien Conditional 

5 AFIDIUM Conditional 
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Other partner comments 

NO COMMENT 

 

Consortium acceptance 

The consortium thereby accepts this release and considers that it covers 

requirements, except for the mapping tool that has only been accepted with 

conditions.  

 

Conditions and Non Acceptance Notes 

The consortium considers that the mapping tool is able to perform simple mapping 

but does not fully comply with the initial expectations in the sense that users are 

supported in easily performing mappings. 

Furthermore, a number of new mappings performed during the tests were not valid 

until technical expertise was involved. 

 

 

For more details on the conditional acceptance of the final Mapping Tool release, see 

also section 4 - Future Recommendations. 


